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Getting Started
This chapter explains how to get started using the Repository Designer.

Repository Designer Overview
Repositories are the cornerstone of TIBCO MDM. All your data and records, both master
and reference, are created, stored, and managed in repositories.

The Repository Designer adds a visual element to designing repositories and makes the
process quicker and more intuitive.

The Repository Designer is based on TIBCO Business Studio and acts as an 'add on'
component to TIBCO Business Studio. The Repository Designer now comes with a new,
MDM specific model editor through which you can design and edit your repository model.
Repository models are now in a .rep format, contained in a special folder called
"Repository Models".

What you can do with the Repository Designer
With the Repository Designer, you can create repositories, modify them, rename them, add
and modify attributes and attribute groups, create self or cross repository relationships,
and export or deploy the final repository model to TIBCO MDM to use it.

You can also import repository metadata exported from TIBCO MDM into the Repository
Designer for further edits.

The Repository Designer also supports the creation of input maps, output maps, and
synchronization format and classification schemes.
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Starting the Repository Designer

Procedure
1. After the installation completes, start the Repository Designer by selecting Start >

Program Files > TIBCO > TIBCO_HOME > TIBCO MDM Studio <version> > Studio
Designer.

2. Provide a workspace location (folder where projects are saved).

Note: You can create multiple workspaces.

Welcome Screen
After you select the workspace for the first time, Eclipse opens up with the Welcome
screen. This contains icons to samples and tutorials among other things.

Note: This Welcome screen shows up only the first time and will not be
displayed for subsequent openings of Eclipse. If you want to go to this screen
again, you can access it from Help->Welcome.
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Accessing Samples
MDM Studio Samples are a collection of the MDM standard processes, process modelling
tutorials, repository data models, rulebase model, custom import project, MDM Model
templates, and Process java transitions.

The sample models are provided to illustrate the modelling capabilities of MDM Studio.
Each of these models needs further elaborations for their intended purpose. Install the
sample projects to view the MDM processes, data models, and their associated rules. All
the samples are available in the TIBCO Home directory.

Follow these steps to install the Samples.

Procedure
1. On the File menu, click Import. The import wizard is displayed.

2. From the General folder, select Existing Studio Projects into Workspace.

3. Click Next. The import wizard for selecting the directory path is displayed.

4. Click Select archive file option. Click Browse and select the sample project zip
archives from \<TIBCOHome>\studio-mdm\<version>\samples folder.

5. Click Finish. The selected project opens in the workspace.

Creating a new Repository Model
To create a repository model from scratch, you first need to create a Project that holds
your model. The following are the steps involved:

Creating a new Project to hold your Repository Model (Step 1 )

Creating a Repository Model (Step 2)

Creating a new Project to hold your Repository
Model (Step 1)

Procedure
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1. Go to File- > New- > Project. Click Next. The Create New MDM Developer Project
wizard is displayed.

2. Select MDM Developer Project and click Next.

3. Provide a name for the Project. Clear the Use default location checkbox if you want
to provide a different location for the project (by default, the current workspace).
Select Destination Environment as MDM. Click Next.

4. The Asset Type Selection dialog is displayed - select Repository Models and click
Next.



TIBCO® MDM Studio Repository Designer User Guide

14 | Getting Started

5. The folder for the Repository Model is displayed. Click Finish.

Result
This creates a new special folder Repository Models. Expand the project in the Project
Explorer to see it.

Creating a Repository Model (Step 2)

Procedure
1. Right-click the Repository Models folder in the Project Explorer and select New -
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Repository Model.

2. Accept the default name for repository model (RepositoryModel.rep) and default
location or enter a new location and name. Click Finish.

Project Explorer
The Project Explorer contains the various MDM project folders.
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MDM Project
The MDM project contains a Repository Models folder.

When you create a new (empty) repository model .rep file (see Creating a new Repository
Model), the repositories you define (along with attributes and attribute groups) and
relationships (along with relationship attributes and relationship attribute groups) are
contained in a Data Domain within the .rep file. The Data Domain can be renamed by right
clicking 'Data Domain' in the Project Explorer.

Expanding the Repository Models folder and all elements under it provides a hierarchical
tree view and you can clearly see the constituents (repositories, inputs maps, attributes,
relationships and so on) of your repository model.

If you double click the Repository Model in the Project Explorer, the editor shows an empty
drawing canvas in which you can design your repository.

If you double click any other element, for example an attribute, the editor opens up (if not
already open) with the selected element highlighted in the design view and its details are
shown in the Properties tab.
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Property tabs
The Property tab contains the following:

l Repository Property section

l Relationship Property section

l Relationship Attribute Group section

Repository Property section
On selecting a repository, you can see the following tabs through which you can view or
modify Repository properties:

General Tab

The General tab displays basic repository properties. For more details, see General Tab

Attributes Tab

The Attributes tab displays Repository Attributes and details. For more details, see
Attributes Tab

Group Sequence Tab

The Group Sequence tab displays attribute group sequence. For more details, see Group
Sequence.

Input Maps Tab

The Input Maps tab displays Repository Input Maps. For more details, see Input Maps Tab.

Output Maps Tab

The Output Maps tab displays Repository Output Maps. For more details, see Output Maps.
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Classification Schemes Tab

The Classification Schemes tab displays the Classification Scheme. For more details, see
Classification Scheme Editor.

Perspectives Tab

The Perspectives tab displays the perspectives. For more details, see Perspective Editor.

Configuration Tab

The Configuration tab displays the perspectives. For more details, see Configuration Tab.

Appearance Tab

The Appearance tab provides the parameters for modifying the appearance. For more
details, see Appearance Tab.

Relationship Property section
On selecting a Relationship, you can view or modify Relationship properties through the
Properties pane, General tab. For more details, see Relationship Properties.

Relationship Attribute Group section
On selecting a Relationship Attribute Group, you can view or modify properties through the
Properties pane, General tab and Attributes tab. For more details, see Relationship
Attribute Properties.

Quick Search
Using the type ahead search dialog you can find diagram entities such as repositories,
attributes or relationships. Press Ctrl + F or click in the toolbar on selected diagram.
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Attribute and Attribute Group Repositioning
The attributes and Attributes groups can be repositioned within the same repository.

Attribute Group Reposition
The repository attribute group can be repositioned within the repository with drag and
drop. For example, the "Contact Number" attribute group is repositioned from the bottom
of the repository to the top of the repository.
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The "Contact Number" attribute group is displayed on the top of the repository.

Attribute Reposition within same Attribute Group
The repository attributes can be repositioned within the same attribute group in a
repository with drag and Drop. For example, the "Home" attribute is repositioned from top
of the attribute group to the bottom of the same attribute group.
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The "Home" attribute is displayed at the bottom of the "Contact Number" attribute group.

Attribute Reposition from one Attribute Group to
another Attribute Group
The repository attribute can be repositioned from one attribute group to another attribute
group within the same repository with drag and drop. If a attribute is repositioned from
one attribute group to other, then it is added as a last attribute in the target attribute
group. For example, the "Home" attribute is repositioned from the "Contact Number"
attribute group to the "Unassigned" attribute group. It is added as the last attribute.



TIBCO® MDM Studio Repository Designer User Guide

22 | Getting Started

The "Home" attribute is repositioned from "Contact Number" attribute group to the
"Unassigned" attribute group.

Palette
The Palette (to the right of the screen) contains different artifacts to help you build your
repository model. Select and drop into the main drawing pane to define or modify your
repository model. You can do the following with the Palette:
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Connectors

Create a relationship between repositories.

Connect a Relationship Attribute Group to a
Relationship.

Nodes

Create a MDM repository.

Create a Relationship Attribute Group.

Create an Attribute Group.

Attributes

Create an attribute within a repository.

Create a relationship attribute within a
Relationship Attribute Group.
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Association Mapping
Using the Association Mapping property, you can choose any attribute as ID (Record Id),
IDEXT (Record ID Extension), or EFFECTIVEDATE. The available mappings in the Association
Mapping drop-down list are NONE, ID, IDEXT, and EFFECTIVEDATE.

EFFECTIVEDATE Mapping

The’Name’ and ’Display Name’ property shows attribute name. The Display name does not
change when you set the association property. So when you deploy a Repository Model
then the Attribute name gets changed to EFFECTIVEDATE and the Display Name would be
same as defined while creating the attribute group.
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PRODUCT ID Mapping
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PRODUCTIDTEXT Mapping
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Repository Attributes and Relationships
This chapter explains how to design your repository complete with attributes,
relationships, and relationship attributes.

Repository Definition
The following are the major steps involved in designing your repository:

l Adding Repositories

l Defining Attribute Groups

l Adding Attributes

l Creating Relationships

l Creating Relationship Attribute Groups

l Defining Relationship Attributes within a Relationship Attribute Group

l Connecting Relationship Attribute Groups to Relationships

l Validating your repository model

l Exporting your repository model

Adding a Repository (Step 1)
You can add the repository from the Palette and also from editor by hovering cursor on
data domain.

From the Palette
To add a new repository, click the icon in the Palette and then click in the main

drawing pane to insert the new Repository; you will be prompted to provide a name for the
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repository.

By default, the repository contains 2 attribute groups Unassigned and System (more
attribute groups can be added as required) with predefined attributes.

When you select a repository in the drawing pane, the Properties Pane displays repository
properties in nine tabs:

General Tab

The General tab displays basic repository properties such as the Name, Display Name,
Description, Table Name, Attribute History and Precedence Management. For more
information on History and Precedence Management refer to Precedence Management
section in TIBCO MDM Customization Guide.

l Attribute History - Specifies whether to collect attribute history for the repository.

l Precedence Management - Specifies whether to enable precedence management for
the repository. This flag cannot be switched on unless Attribute History is set to true.
When it set to true, a new attribute SOURCEID is added under the System group in
the repository. You can move the SOURCEID attribute to another group but this
attribute cannot be deleted. If you disable the precedence management, the
SOURCEID attribute is not removed.
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Attributes Tab

The Attributes tab displays Repository Attributes and details. You can view, add, delete
attributes, edit attribute properties, move attribute positions, and create Attribute Groups.

Group Sequence Tab

The Group Sequence tab displays the current sequence of attribute groups which you can
reorder as required.
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Input Maps Tab

The Input Maps tab displays Repository Input Maps. For more information on input map
refer, Input Maps

Output Maps Tab

The Output Maps tab displays Repository Output Maps. For more information on output
map refer, Output Maps

Classification Schemes Tab

The Classification Schemes tab allows you to view and create classification scheme. For
more information on creating classification scheme using the property section refer, Using
Classification Scheme Property Section
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Perspectives Tab

The Perspectives tab displays the Perspective defined for a particular repository. For more
information on perspective refer, Perspective Editor Overview

Configuration Tab

The Configuration tab can be used to modify the visibility configuration of the repository.
By default, the attributes groups are visible, to switch the visibility of the attribute group,
uncheck the checkbox corresponding to the attribute group.

You can change the Repository Label Text of the repository to display either the Name or
Display Name. Similarly you can change the Attribute Label Text to either Name or
Display Name.
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Appearance Tab

The Appearance tab is used to modify the appearance of the particular repository,
attribute group, relationship attribute, and relationships. For more information on
Appearance refer, Appearance Tab.

From the Callout Handler
You can add the Repository using the callout handler in the editor.

Procedure
1. Hover the mouse on the editor, the Add Repository and Add Relationship Attribute

Group icons are displayed.
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2. Click the Add Repository icon, the new Repository gets added in the editor.

3. Similarly click the Add Relationship Attribute Group icon, the new Add Relationship
Attribute Group gets added in the editor.

Defining Custom Properties for Repositories
You can define custom properties for a repository by using the Configurations >
repositoryAdvancedProperties.properties file. To define new custom properties for a
repository, complete the following the steps:

Procedure
1. From the Project Explorer, navigate to Configurations and open the

repositoryAdvancedProperties.properties file.

2. Add new properties in the following format key=Datatype#Value. For example,
match=String#false,true.

For a multivalue property, add comma separated values. You can view repository
specific properties and edit their values in Properties > Advanced.
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Defining Attribute Groups (Step 2)
An Attribute Group represents a logical grouping of the attributes in a repository. Each
attribute is assigned to an attribute group.

To create an attribute group:

Procedure
1. Click the icon in the Palette and then click in the Repository to add the

Attribute Group.

2. Enter a name for the attribute group. You can now add new attributes to the group.

By default, a repository contains 2 attribute groups Unassigned and System.

l Unassigned Attribute Group

This group contains the ID, IDEXT and CONTAINS predefined attributes.

l ID represents the primary identity attribute of a data record. It maps to
the TIBCO MDM attribute PRODUCTID and it is a unique identifier for each
of the records.

l IDEXT is the secondary identifying attribute for a data record and maps to
PRODUCTIDEXT in TIBCO MDM.

l CONTAINS maps to the CONTAINS attribute (Related Record) in TIBCO
MDM.

l System Attribute Group

This contains system attributes (such as Last Modified On, Last Modified By,
Active, Created On, Owner Id, Last Confirmed Version) that cannot be seen but
are present to maintain version and audit information. If you define any custom
system attributes, you can see them when you expand the group.

l Group Sequence

The order of attribute groups can be controlled from the Group Sequence tab.
Select a repository in the drawing pane and click the Group Sequence tab in
the Properties Pane. A list of all attributes groups for that repository is
displayed and you can change the order by selecting the group to move and
using the up and down buttons.
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l Attribute Group Properties

The General tab displays basic attribute group properties such as the Name and
Description.

Note: You can modify the Attribute Group name in the editor by
double clicking on the group name and inline editing.

Defining Custom Properties for Attribute Groups
You can define custom properties for an attribute group by using the Configurations >
attrGroupAdvancedProperties.properties file. To define new custom properties for an
attribute group, complete the following the steps:

Procedure
1. From the Project Explorer, navigate to Configurations and open the

attrGroupAdvancedProperties.properties file.
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2. Add new properties in the following format key=Datatype#Value. For example,
match=String#false,true.

For a multivalue property, add comma separated values. You can view the attribute
group specific properties and edit their values in Properties > Advanced.

Adding Predefined Attribute Groups
By using the predefined attribute group feature in TIBCO MDM Studio, you can create
customized attribute groups based on your specific needs. You can use these attribute
groups in any repository model across the project.

These attribute groups can be defined in the predefinedAttributeGroups.xml
configuration file. This file is added in the Configurations folder when you create a new
project in TIBCO MDM Studio. By default, this file has no content.

Before you begin
Ensure that you have configured your attribute groups in the
predefinedAttributeGroups.xml configuration file and placed it in the Configurations
folder.

Complete the following steps to add predefined attribute groups:

Procedure
1. Select a repository and then click Properties > Attributes > Add Attribute Group.

The New Attribute Group dialog is displayed.
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Note: Ensure that the new attribute group has a unique name. A validation
error message is displayed if there is already an attribute group with the
same name in the selected repository.

Note: Ensure that the new attribute group has unique attributes. A
validation error message is displayed if the same attributes are present in
other attribute groups in the selected repository.

2. Select Add Predefined Attribute Group and then select an attribute group from the
Select Attribute Group dropdown list. The list of attribute groups displayed in this
dropdown list are defined in the predefinedAttributeGroups.xml configuration file.

3. After you have selected an attribute group, click Finish. The selected attribute group
is added to the repository.
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Sample predefinedAttributeGroups.xml
<?xml version="1.0" encoding="UTF-8"?>
<AttributeGroups>
<AttributeGroup>
<AttributeGroupInfo>
<Name>SampleAttributeGroup1</Name>
<Description>SampleAttributeGroup1</Description>
<Property type="Boolean" name="sampleProperty1">true</Property>
<Property type="String" name="sampleProperty2">sampleProperty</Property>
</AttributeGroupInfo>
<Attributes>
<Attribute>
<Name>SampleAttribute1</Name>
<Description>Sample attribute 1</Description>
<DisplayName>SampleAttribute1</DisplayName>
<Length>255</Length>
<ColumnName>attributeColumn1</ColumnName>
<Help/>
<DataType>String</DataType>
<Searchable>N</Searchable>
<DisplayInRecordList>Y</DisplayInRecordList>
<QuickViewable>Y</QuickViewable>
<MultiValued>N</MultiValued>
<CategorySpecific>N</CategorySpecific>
<PartitionKey>N</PartitionKey>
<MultiValueTableName/>
<UseCommonTable>N</UseCommonTable>
<Property type="Boolean" name="attribute1property1">true</Property>
<Property type="String"
name="attribute1property2">AttributeProperty</Property>
</Attribute>
<Attribute>
<Name>SampleAttribute2</Name>
<Description>Sample Attribute 2</Description>
<DisplayName>SampleAttribute2</DisplayName>
<Length>0</Length>
<ColumnName>attributeColumn2</ColumnName>
<Help/>
<DataType>Decimal</DataType>
<Searchable>N</Searchable>
<DisplayInRecordList>N</DisplayInRecordList>
<QuickViewable/>
<MultiValued>N</MultiValued>
<CategorySpecific>N</CategorySpecific>
<PartitionKey>N</PartitionKey>
<MultiValueTableName/>
<UseCommonTable>N</UseCommonTable>
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<Property type="Boolean" name="attribute2Property1">false</Property>
<Property type="String"
name="attribute2Property2">AttributeProperty</Property>
</Attribute>
</Attributes>
</AttributeGroup>
</AttributeGroups>

Exporting Attribute Groups
You can export existing attribute groups to use in other repositories. Follow these steps to
export an attribute group:

Procedure
1. Select a repository from where you want to export the attribute group.

2. In the Properties tab, click Attributes and then click Export Attribute Group. The
Export Attribute Group wizard is displayed.

The Select Attribute Group dropdown menu lists all the attribute groups present in
the selected repository.

3. Select the attribute group that you want to export from the Select Attribute Group
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dropdown list and click Next. The next page is displayed where you can validate the
selected attribute group.

4. Provide a unique name for the attribute group and click Validate. Ensure that the
Attribute Group Name is unique and not already present in the
predefinedAttributeGroups.xml file. If the validation is successful, it means the
name is unique. If the validation fails and you still click Finish, the selected attribute
group in the predefinedAttributeGroups.xml is overwritten.

5. Click Finish to export the selected attribute group.

Defining Attributes (Step 3)
Attributes define the structure of a repository. To create attributes:

l Click the icon in the Palette and then click in the Repository (under an
attribute group) to add the Attribute.

l Enter an attribute name.

Attribute properties can be edited directly by clicking the attribute or selecting the
repository and then clicking the Attributes tab in the Properties window.

Attributes can be reordered by dragging and dropping the attribute properties. Add and
Delete icons are provided to add and delete an attribute property. Select an attribute and
use the delete icon to delete it, or use the add icon to add an attribute.

You can change the flag property by a single mouse click. You can modify all the attribute
properties in the property section. The size of attribute columns in property section is
arranged to show more data.

Click the Add Attribute Group button if you want to create a new attribute group or add a
predefined attribute group. Click the Group Sequence button if you want to reorder
attribute groups.

When you select an attribute group in the drawing pane, the Properties tab displays all
attributes within that attribute group. You can see and add the General and Advanced
information per attribute:
General Tab
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l Name - The name for the attribute (maximum of 30 characters, a-z, A-Z, 0-9 and _)

l Display Name - The display name for the attribute (maximum of 60 characters, less
restrictive naming conventions compared to name). Duplicate display names are
allowed.

l Description - Description for the attribute (maximum of 4000 characters).

l Type - The data type for the attribute (String, File, Amount, Boolean, Integer, Date,
Decimal, Custom Decimal, Timestamp, Long, and URL). The Long data type is native
data type which maps to Java Long. The maximum length is 19. The URL is a derived
data type based on String. The maximum length is 4000 and default length is 256. If
the length is zero or blank value, default length is assigned. The Custom Decimal is
like the Decimal data type. The maximum length is 29. The custom decimal is
indicated by the decimal length 29 minus the assigned length. For example, (18,11).

l Length - Attribute length

l Column Name - A unique database column name for the attribute. Name must
comply with database requirements if database has validations defined for attribute
column name.

l Association Map - Can choose any attribute as ID (Record Id), IDEXT (Record ID
Extension), or EFFECTIVEDATE. The available mappings in the Association Mapping
drop-down list are NONE, ID, IDEXT, and EFFECTIVEDATE.

l Help

l Searchable - Select to mark the attribute for display in search results.
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l Display In Record List - Select this option to display the attribute in the Record List

l Quick Viewable - Select to include the attribute in the Quick view section of the
Record Relationship tab.

l Category Attribute - Select this option to define the attribute as a Category Specific.
When an attribute is defined as Category Specific, you can either enter a table name
or use common tables. Category Specific attribute share the same predefined
common tables used for multi-value attributes. In addition, the new predefined MV_
SHARED_BOOLEAN_TABLE table is available for the Boolean data type.

l Multi Value - Whether attribute is multi-value.

l User Common Table - Whether the multi-valued/category specific attribute uses
predefined common table.

l MultiValue Table Name - The multi-value table name if the attribute is a multi-value
attribute.

l Partition Key - Select to define the attribute as partition key.

l Position - The position for the attribute.

Advanced Tab

The Advanced tab displays the advanced properties for attribute. The default advanced
properties are as follows:

1. Required

2. Quality Mode

3. Quality Categorization

4. Quality Goal
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In addition to the existing properties, you can define custom properties for attributes by
using the Configurations > attributeAdvancedProperties.properties file of the studio
project. After adding the custom property, the newly added custom property appears in the
Advanced tab in the properties section.

l Required - Specify if you want attribute as mandatory attribute.

l QualityMode - Displays the selected quality mode. The available options are:

o NONE : indicates that the quality mode is not selected.

o DEFINED : indicates that the attribute has a value. That means, the value
should not be empty.

o VALIDATED : indicates that a rulebase constraint has been associated with the
validation of the attribute.

o VERIFIED : indicates the verification of an attribute, that is, external validation.
For example, address verification and email verification.

l QualityCategorization - attribute name in which the quality attribute is categorized.

l QualityGoal - indicates the quality value of an attribute.
To add the new custom attribute property, open the
attributeAdvancedProperties.properties file, enter the new property as
Propertyname=DataType#Value. If you have more than one values, enter the values
separated by semi colon. The values appear as a drop-down list. Only primitive data types
like string, integer, double, boolean are supported. For example,

l isEmployee=Boolean#True,False
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l Address=String#PaloAlto

Note: The new custom attribute property to be effective, you must restart TIBCO
MDM Studio.

Defining Relationships (Step 4)
A Relationship represents a connection between two repositories. You can define two types
of relationships:

l Self relationships where relationships are defined between records in the same
repository.

l Cross repository relationships which are defined across records in different
repositories.

A - Creating Relationship(s)
To create a relationship:

Procedure
1. Click the icon in the Palette and then click the edge or the header of

the source Repository (that you want to create the relationship from).

2. Drag the mouse towards the target repository and release the mouse button.

3. Enter a relationship name and reverse relationship name. Appropriate icons (arrows)
denote the forward and reverse relationships on the relationship connector.
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Result

Note: If you attempt to create a relationship when you have only one repository
or if you only select a source but not a target repository, you get an option to
automatically create a second or new repository.

Relationship Properties

If you select a Relationship in the drawing pane, its properties are displayed in the
Properties pane. This is a representation of the MDM Relationship Definition table. It
displays Relationship properties such as the Name, Description, Reverse Name, Reverse
Description, Source Repository and so on.
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B- Creating Relationship Attribute Group(s)
A Relationship Attribute Group serves as a container for one or more Relationship
Attributes.

You need to first define a Relationship Attribute Group before you define Relationship
Attributes (see C - Defining Relationship Attributes).

To define a Relationship Attribute Group:

Procedure
1. Select the icon in the palette.

2. Click in an area outside of the repositories, close to the desired relationship. A gray
box is added, this is the Relationship Attribute Group.

Result

Relationship Attribute Group Property

The General tab displays relationship attribute group property Table Name.
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C - Defining Relationship Attributes

When a relationship is defined, one or more attributes can be defined for the relationship
(similar to repository attributes).

You need to first define a Relationship Attribute Group before you define relationship
attributes (see B- Creating Relationship Attribute Group(s)).

To create a relationship attribute:

Procedure
1. Click the icon in the Palette and then click in a (previously defined)

Relationship Attribute Group.

2. Enter the Relationship Attribute name.

3. Relationship Attribute properties can be changed by clicking the relationship
attribute and making edits in the Properties window General tab or by selecting the
Relationship Attribute Group and making edits in the Properties Window Attributes
tab.

Result

Note: Relationship attributes cannot be defined as Category Specific Attributes.
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Relationship Attribute Properties

If you select a Relationship Attribute in the drawing pane, its properties are displayed in
the Properties pane, General tab.

If you select the entire Relationship Attribute Group, details of all the contained
relationship attributes are displayed in the Properties pane, Attributes Tab.

D - Connecting the Relationship Attribute Group to
the Relationship

Once you define Relationship Attributes within a Relationship Attribute Group, you need to
connect the Relationship Attribute Group to the Relationship. To do this:

Procedure
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1. Select the Group Connector icon under Connectors in the Palette.

2. Make a connection from the relationship attribute group to the relationship by
clicking the edge of the relationship attribute group box and dragging up to the
relationship line.

Result

Relationship Attribute Groups (and their Attributes) have a collapsible display.

Once you successfully connect a relationship attribute group to a Relationship, you can
see a small icon on the relationship which shows as a minus when the relationship
attribute group and its attributes are maximized or as a plus when minimized.

Importing your TIBCO MDM Repository

Note: This section presumes that you have defined a repository in TIBCO MDM
(with or without artifacts such as attributes, relationships and so on), exported it
by inputting the request XML (with the repository name) through the Export
Metadata UI in TIBCO MDM, and taken the JAR file generated (containing the
meta data XML).

Procedure
1. Create a Project file (See Creating a new Project to hold your Repository Model (Step

1 )), right click the Repository Models folder and select Import.

2. Select Import Repository Meta Data under MDM Repository Designer. Click Next.
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3. Browse and select the location where the JAR file has been extracted and ensure the
associated XML file is displayed on the right.
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4. Click Finish.

Result
Your imported repository should now show in your project along with any related artifacts.

Exporting a Repository Model
The Export Wizard is used to export the graphically designed repository model to TIBCO
MDM in .xml file format.

Procedure
1. Select the Project in the Project Explorer and click File- > Export or right click the

project and select Export.

2. Select MDM Metadata Format under MDM Repository Designer. Click Next.

3. Select the <repositorymodelName>.rep file for export by selecting the checkbox. The
default location to which the file gets exported is displayed in the Destination
section under Project (/Exports/MDMExportFolder). You can change the path if
required. Click Finish.
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If you chose to export to the Project itself, in the Project Explorer, you can now see a
new folder Exports/MDMExportsFolder created which contains the XML file that was
generated.

Result
You can now import your Repository model into TIBCO MDM.
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Importing a Repository Model
Once you export the Repository model (XML file), you can import it into TIBCO MDM.

Procedure
1. Start the TIBCO MDM application.

2. Go to System Operations-Import Meta Data. Browse to select the .xml file
exported from the Repository Designer. Click Upload.

3. You can see details of the file you selected for upload. You can click the Check
Progress link to see the status.
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4. You can check the status of the process from the Event Log. If the Event shows as
complete without any error, it means the repository model was successfully imported
in TIBCO MDM.

5. Go to the Repositories page to check if your repositories have got added.

6. You can also see any relationships that you created between your Repositories in the
Repository Designer. For instance, if you created Repository 1 and Repository 2 with a
relationship between them you can see that in the TIBCO MDM UI.
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Appearance Tab
You can change the appearance of the repository model elements. The Appearance tab
provides different icons using which you can change the font, color and styles of the
repository, attribute group, relationship attribute group, and the relationships.

Appearance Tab For Repository
You can change the appearance of the Repository. Use the following icons to change the
appearance.

Fonts and
Colors

Descriptions

To make bold style font of the repository header.

To make italic style of the repository header.

To change the color for the font name of the
repository header.

To change the line color of the repository header.

To change the upper gradient of the repository
header.

To change the bottom gradient of the repository
header.

Procedure
1. Select the repository for which you want to change the appearance in the editor and

click the Appearance property tab in property section.
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2. The Fonts and Colors group is displayed. Select the new font and size for the
repository name.

3. To change the style click the respective icons. To change the colors for repository
header click respective icon.

4. The repository with the new appearance is displayed in the editor.

Appearance Tab For Attribute Group
You can change the appearance of the repository attribute group. Use the following icons
to change the appearance.

Fonts and
Colors

Descriptions

To make bold style font for attribute groups and
attributes in that group.
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To make it italic style for attribute groups and
attributes in that group

To change font color for attribute groups and
attributes in that group

To change the line color for attribute group.

To change the header color of the attribute group.

Procedure
1. Select the repository attribute group for which you want to change the appearance in

the editor and click on the Appearance property tab in property section.

2. The Fonts and Colors group is displayed. Select the new font and size for the
attribute group.

3. To change the style click on the respective icons. To change the colors for attribute
group header click on respective icon.
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4. The repository attribute group with the new appearance is displayed in the editor.

Appearance Tab For Relationship Attribute
Groups
You can change the appearance of the relationship attribute group. Use the following icons
to change the appearance.

Fonts and
Colors

Descriptions

To make bold style font for relationship attributes in
that group

To make it italic style for relationship attributes in
that group
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To change font color for relationship attributes in
that group

To change the line color for relationship attribute
group.

To change the color for the relationship attribute
group

Procedure
1. Select the relationship attribute group for which you want to change the appearance

in the editor and click on the Appearance property tab in property section.

2. The Fonts and Colors group is displayed. Select the new font and size for the
relationship attribute group.

3. To change the style click on the respective icons. To change the colors for
relationship attribute group click on respective icon.

4. The relationship attribute group with the new appearance is displayed in the editor.
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Appearance Tab For Relationship
You can change the appearance of the relationship. Use the following icons to change the
appearance

Fonts and Colors

To make bold style font for relationship.

To make it italic style for relationship.

To change font color for relationship.

To change the line color for relationship.

Procedure
1. Select the relationship for which you want to change the appearance in the editor

and click on the Appearance property tab in property section.

2. The Fonts and Colors group is displayed. Select the new font and size for the
relationship.

3. To change the style click on the respective buttons. To change the colors for
relationship click on respective icon.
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4. The relationship with the new appearance is displayed in the editor.
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Data Source Editor
This chapter introduces you to the concept of Data Sources in TIBCO MDM Studio and
explains how to use this feature.

Data Sources Overview
Data sources are used to import data into repositories, identify records to create subsets
and transform data. Data sources model external sources of information, such as any file
that you want to upload.

Data sources can be used to:

l Imports record into repositories.

l List to define a subset.

l List of valid values for validation and cleansing.

l Input to data validation rules and so on.

The Data Source Designer is based on TIBCO Business Studio and integrated in Repository
Designer. The Data Source Designer provide TIBCO MDM specific Data Source editor
through which you can design and edit your data source model. Data Sources are in .ds
format, contained in a special folder in TIBCO MDM Studio called "Datasources".

Data Source Properties
The Data Source Properties are as follows:

l Name: The Data Source name must be unique and can contain A-Z, 0-9, all special
characters (except a space), and characters from other languages too.

l Description: The Data Source Description.

l Delimiter Character: The delimiter character can be a Comma, Pipe, Semicolon,
Colon, Space, Tab or Other character chosen by the user.
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l Date Format: The date format must match the actual date format. If specified
incorrectly, data may be rejected or loaded incorrectly. For example, if the date
format is specified as MM/DD/YY, and the actual data is specified in DD/MM/YY, then
02/01/12 may be imported as Feb-01-2012 instead of Jan-02-20120.

l Text Qualifier Character: The text qualifies can be a double quote, Single quote, or
any other qualifies chosen by the user.

l Use Column Names: If selected, the column names are the first row of the data in
the file you are uploading. If not selected, you have to create the attribute names
manually while creating the data source.

l Start Import at Row Number: The row number from which the application starts
importing data into the repository.

l Format:

o Delimited

o Fixed Length

o Database

l Table Name: If you have selected the Database format, the Table Name field
appears. The table name must be available in the TIBCO MDM database. You cannot
connect to a different database.

l Data File: Click the ... button next to the Data File field to navigate to and select the
data source file. After you select the file, the selected filename appears.

l Timestamp Format: Select the timestamp format in the Timestamp Format drop-
down list. By default, YYYY-MM-DD HH:mm:ss timestamp format is displayed. If the
actual data contains a different format, you can change it. The timestamp format
must match the timestamp format used in the actual data. If you specify incorrect
timestamp format, data may be rejected or loaded incorrectly.

What you can do with the Data Source Designer
With the Data Source Designer, you can create data sources, modify them, customize
attributes, and export the final data source model to TIBCO MDM. You can also import
multiple Data Source metadata exported from TIBCO MDM into the Data Source Designer
for further edits or you can use it to define Input map using Input Map Editor.
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Creating a New Data Source Model

Procedure
1. Right-click on the Datasources folder in the Project Explorer and select New - >

Data Source Model.

Note:

The Data Sources special folder can be created if it is not available in
project.

To create new Data Source special folder do the following:

l Right click on project, Select New- > Folder

l Provide a name for the folder and Click Finish

l Right click on newly created folder and Select Special Folders - >
Use as Datasource Folder.

2. The New Data Source Wizard is displayed.
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3. Specify a name for the Data Source Model file in the File Name field.

4. Click Next.

5. The data source property page is displayed.

6. Enter the Data Source Name and Description in the Name and Description fields.

7. Select the Data Source Format. The available options are:

l Delimited
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l Fixed Length

l Database

The rest of the fields vary depending on the format selected. For example, if you
have selected the Database format, only Name, and Description fields are
displayed.

8. Delimiter Character. Select the appropriate delimiter character from the drop-down.
The delimiter character can be a Comma, Pipe, Semicolon, Colon, Space, Tab, or
Other character.

9. Text Qualifier. Select the appropriate Text Qualifier from the drop-down. The text
qualifies can be a double quote, Single quote, or any other qualifier.

10. Click Next.

Note:

l Data field may contain Delimiter character. In such case data field
should be enclosed with Text Qualifier.

l The backslash (\) is not supported as delimiter.

11. The data source file selection page is displayed.

12. Select the Copy data source file in the project checkbox to include the data files in
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the project. Browse to the folder where the data source file is saved and select the
data file. Click Finish.

Note: You can create a data source without selecting the Copy data
source file in the project checkbox. The data source is created without
the data file in the project folder.

13. When Data Source Format selected is Fixed Length. The Data Source Attributes
section is displayed. Create the Data Source attributes for the Fixed Length Data
Source.

Modifying an Existing Data Source
Using the Data Source Editor you can modify the existing Data Source in the project. The
Data Source Editor has three sections.

l Data Source Configuration: Here you can modify the basic details, such as name of
the data source, description, delimiter and other details. If you have given any cross
reference to the data source then the Data Source Configuration will appear in read
only mode.

l Attributes: All the attributes of data source can be viewed and modified in this
section. Click to add new attributes. Attribute names cannot be more than 28

characters and must contain only ASCII (A-Z, a-z, 0-9, _). Attribute Position, Type and
Length are set after finishing data source creation wizard. Delimited Data Source
attribute data type is predicted on data source file column data. Data Type can be
further changed from the Type column in attribute table. To delete an attribute
select the checkbox corresponding to the attribute and Click .

l Data Source Preview: Here you can preview the initial few lines of the Data Source
files. Color scheme is imposed on data according to data type in Data Source
preview. The following color is used:

o Blue : String,

o Green: Integer

o Magenta: Boolean

o Red: Error in data
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Note: Data preview line can be configured from Preview Lines preference
property (Default value is 50). Preview line property can be accessed from
Studio menu Windows->Preferences->Repository Designer->Data Source
Editor.

Importing an Existing Data Source Model
Using the Import Wizard you can Import Data Source model into TIBCO MDM Studio.

Procedure
1. Right-click on the Datasources folder in the Project Explorer and click Import.
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2. The Import Wizard is displayed. Expand MDM Data Source Designer, select
Datasource Meta Data and click Next.

3. Browse to the folder in which valid data source meta data xml file is saved. Select the
data source xml file and click Finish.



TIBCO® MDM Studio Repository Designer User Guide

70 | Data Source Editor

Result

Note: Import Wizard supports only single data source import in data source
meta data xml file.

During Import you can import multiple data source model.

Exporting a Data Source
Using Export Wizard you can export Data Source model in TIBCO MDM Data Source format.

Procedure
1. Right-click on the Datasources folder in the Project Explorer and click Export-- >

Export.
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2. The Export Wizard is displayed. Expand MDM Data Source from export destination
list, select MDM Data Source Format and click Next.

3. Select the Data Source Model which you want to export. By default Data Source
Model is exported to Exports/MDMExportFolder directory which is in same project.
You can change the location by specifying different destination path. Click Path and
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browse to the folder in which you want to export the Data Source Model xml file and
click Finish.

Deploying a Data Source
When a repository model (.rep file) is deployed, all the corresponding data source and its
data file are also deployed.

Note: While deploying data source ensure that the data source data file size is
limited to 10 MB. If you want to upload data file more than 10 MB, change the
preference property Windows- > Preferences- > Repository Designer- > Data
Source- > Data Source File Size Limit. However, it is recommended to upload
data files with less than 10 MB file size.

Procedure
1. In the Deployment pane, right click the <MDM Server and select Deploy Module.
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2. Select the data source to deploy. Click Next.

3. Select the enterprise to deploy the modules to (either the current enterprise or
standard). Click Next. The selected modules is sent to the server for server side
validations. The validation progress bar is shown at the bottom of the page.
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4. The validation result page is displayed with the validation messages. The errors and
information messages are shown in separate sections. If there are validation errors,
the Finish button is disabled. Click Next.

5. Select the data source to upload, if the data source file contains the corresponding
data files (*.csv, *.txt and so on) it will also be uploaded. Click Finish.

6. The data source is successfully deployed.
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7. Log onto the TIBCO MDM Server and check if your data source have got included.

Result
For more information of deploying refer to, Deployment.
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Synchronization Format Editor
This chapter describes how to design synchronization format in TIBCO MDM Studio.

TIBCO MDM Studio provides wizard to create Synchronization format and an editor that
allows you to configure properties and define attribute groups and belonging attributes.
These attributes are then mapped with the repository attributes in the output map editor.

Synchronization Formats Overview
Synchronization formats define the attributes and structure of the data required by the
consumers of that data. The output map defines mappings of repository attributes to
synchronization format. When a repository is synchronized, the synchronization format
provides the structure for the output information.

The Synchronization format editor provides you with a User Interface that helps create
Synchronization format which can then be referred in the Output Map during mappings.

While creating a new MDM Developer project, the synchronization special folder named
Sync Format is created. If the Sync format folder is not created you can manually create
the special folder. For more information, refer to Creating the Synchronization Format
Special Folder.

Creating the Synchronization Format Special
Folder
While creating a new MDM Developer project, the synchronization special folder named
Sync Format is created. If the Sync format folder is not created you can manually create
the special folder.

Procedure
1. Right click the MDM Developer Project, point to New and click Folder. Enter a user
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friendly name in the Folder name field. For example, Sync Format. Click Finish.

2. A folder by the name Sync Format is created in the MDM Developer Project.

3. To designate it as a special folder, right click newly created folder (Synch Format)
and select Special Folder and click Use as Synch Formats.
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4. The newly created folder gets designated as Special Folder by the name Sync Folder.
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Creating a Synchronization Format

Procedure
1. Right click on the Sync Format Special folder, point to New and click Sync Format

Model.

2. Enter the appropriate file name for the synchronization format in the File name field.
The extension of the file name must be .sf.
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3. Click Next. The properties of the synchronization format are displayed.

4. Enter or select the appropriate values in the respective fields.
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Field Description

Name The synchronization name must be unique and
can contain A-Z, 0-9, all special characters (except
a space), and characters from other languages.

Description The synchronization format description. The
description field does not allow more than 80
characters. However, white spaces are allowed in
the description.

Delimiter
Character

The delimiter character can be a Comma, Pipe,
Semicolon, Space, Tab, or Other character. The
backslash (\) is not supported as delimiter.

Text Qualifier
Character

The text qualifier can be a double quote, Single
quote, or any other qualifier. Data field may
contain Delimiter character. In such case data
field should be enclosed with Text Qualifier.

Date Format The date format must match the actual date
format. If specified incorrectly, data may be
rejected or loaded incorrectly. For example, if the
date format is specified as MM/DD/YY, and the
actual data is specified in DD/MM/YY, then
02/01/12 may be imported as Feb-01-2012 instead
of Jan-02-20120.

TimeStamp
Format

The timestamp format must match the timestamp
format used in the actual data. If you specify
incorrect timestamp format, data may be rejected
or loaded incorrectly. By default, YYYY-MM-DD
HH:mm:ss.S timestamp format is displayed.

If the actual data contains a different format, you
can change it.
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Field Description

Table Name The table name where the synchronized data is
stored.

Header Required Select the checkbox if you want the header to
appear in the synchronized output file.

Fixed Length Select the checkbox if you want the synchronized
file to be of fixed length.

5. Click Finish. The synchronization format editor for the newly created synchronization
format is displayed.

Modify Existing Synchronization Format
Using the Synchronization Format Editor you can modify the existing Synchronization
Format in the project. The Synchronization Format Editor has two sections.

Note: The default synchronization formats cannot be modified. Only the
synchronization formats that you create can be modified. Also, you cannot
modify the synchronization format that is in use for Output Map or Export.

l Synchronization Format Configuration: Here you can modify the basic details, such
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as name of the data synchronization format, description, delimiter character, text
qualifier character, data format, timestamp format, table name, and other details.

l Attributes: All the attributes of synchronization format can be viewed and modified
in this section. Click to add new attributes.

Field Description

Position The position of the of synchronization format
attribute.

Name Name of the of synchronization format attribute.

DisplayName The display name of the synchronization format
attribute.

Description The description of the synchronization format
attribute.

DataType The data type of the synchronization format
attribute. The supported data types are String,
File, Amount, Boolean, Integer, Date, Decimal,
Custom Decimal, Timestamp, Long, and URL.

Length The length of the synchronization format
attribute.

ValueIsList Specify whether the synchronization format
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Field Description

attribute is a list value. The possible value is true
or false. It is a toggle field.

MaxNumberOfValues Specify the maximum number of values to be
displayed after the synchronization format. By
default it takes ALL (-1).

SortOrder Specify the sort order of the synchronization
format.

ColumnName Specify the column name of the synchronization
format attribute.

Required Specify whether the synchronization format
attribute is a required field. The possible value
are true or false. It is a toggle field.

Searchable Specify whether the synchronization format
attribute should be a searchable value. The
possible value are true or false. It is a toggle
field.

DisplayInRecordList Specify whether the synchronization format
attribute should be displayed during the record
search. The possible value are true or false. It is
a toggle field.

l To delete an attribute select the checkbox corresponding to the attribute and click
.

Manage Attribute Groups
Using the Synchronization Format Editor you can create and manage the attribute groups
for a synchronization format.
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Creating a New Attribute Group
The attribute property section allows you to create a new attribute group.

Procedure
1. On the property section, click .

The new attribute group is created in the synchronization format editor. To create
attributes in the attribute group, see Modify Existing Synchronization Format.

2. To change the order of the attribute groups use or .

3. To delete a attribute group select the attribute group and click .

Renaming the Attribute Group
You can change the default attribute group name.

Procedure
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1. On the project explorer, select the <Attribute Group> which you want to rename.

2. Right-click and select Rename.

3. Enter the new attribute group name.

Importing a Synchronization Format
Using the Import Wizard you can import Synchronization Format into TIBCO MDM Studio.

Procedure
1. Right-click on the Sync Formats folder in the Project Explorer and click Import.
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2. The Import Wizard is displayed. Expand MDM Synchronization Format Designer,
select Sync Format Meta Data and click Next.
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3. Browse to the folder in which valid sync format meta data xml file saved. Select the
sync format xml file and click Finish.



TIBCO® MDM Studio Repository Designer User Guide

89 | Synchronization Format Editor

Exporting a Synchronization Format
Using Export Wizard you can export a Synchronization Format in to TIBCO MDM metadata
xml format.

Procedure
1. Right-click on the Sync Formats folder in the Project Explorer and click Export-- >

Export.

2. The Export Wizard is displayed. Expand MDM Synchronization Format from export
destination list, select MDM Synchronization Format and click Next.
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3. Select the synchronization format which you want to export. By default
Synchronization Format is exported to Exports/MDMExportFolder directory which is in
same project. You can change the location by specifying different destination path.
Click Path and browse to the folder in which you want to export the synchronization
format xml file and click Finish.



TIBCO® MDM Studio Repository Designer User Guide

91 | Synchronization Format Editor

Deploying a Synchronization Format
In deployment wizard, sync formats are listed under Sync Formats folder and can be
deployed independent of repository model. When a repository model (.rep file) is deployed,
all the corresponding synchronization formats are also deployed.

Procedure
1. In the Deployment pane, right click the <MDM Server and select Deploy Module.
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2. Select the synchronization format to deploy. Click Next.

3. Select the synchronization format to deploy and click Next.
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4. Click Finish.

5. The synchronization format is successfully deployed.

6. Log onto the TIBCO MDM Server and check if your synchronization format have got
included.

Result
For more information of deploying refer to, Deployment.
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Classification Scheme Editor
This chapter introduces you to the concept of Category Specific Attributes in TIBCO MDM
Studio and explains how to design and deploy the Classification Scheme using
Classification Scheme Editor.

Overview
The Classification Scheme allows you to arrange the various categories of the products in a
particular hierarchy. The Classification Scheme Editor allows to define the Category Code
hierarchy. Some of the features supported by Classification Editor are as follows:

Editing Category Tree
l Allows adding child and sibling Classification Code.

l Allows Inline editing of the Classification Code name on the tree node and
Classification Code Property section allows editing of the code, name, and
description.

l Allows linking and unlinking of Category Specific Attributes to Classification Code.

Browsing Category Tree
l Allows browsing and searching of Classification Code within the tree based on the

name.

l Allows viewing of linked attributes and the inherited attributes.

The Classification Scheme which are defined using the Classification Scheme Editor are
deployed using the TIBCO MDM Studio. Since the definition of Classification Scheme is
managed in TIBCO MDM Studio, it is necessary to deploy all the artifacts to the TIBCO MDM
Server.
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For example, in large departmental stores we find all the products we need in our day to
day life. It is well organized and arranged such that customers can easily find the items in
their shopping list. From the retailer's point of view, managing such huge products and
stock taking is a challenge. Hence the products are grouped and sub-grouped, categorized
and sub-categorized depending on the nature of product. Thus allowing the retailer to
capture the various details of a product based on its group and category.

Create Classification Schemes
The Classification Schemes are created using the following two ways:

l Classification Scheme wizard.

l Classification Scheme property section.

Using Classification Scheme Wizard

Procedure
1. Select the Repository Model for which you want to create the classification and right-

click on New > Classification Scheme.
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2. The Classification Scheme wizard is displayed.
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Field Description

Root Repository
Name

The repository name for which the classification
scheme is created. The Root repository name is
view only field if we select the particular
repository. However, if we select repository
model file having more than one repository then
we can change the repository.

Name Name of the Classification Scheme. The
Classification Scheme Name cannot exceed 78
characters. The Classification Scheme name is
mandatory.

Description The description for the Classification Scheme.
The classification description is mandatory.

Extraction Type Select the appropriate extraction type from the
drop-down. The available options are Manual,
Automatic, and Mixed. By default, Manual is
displayed.

Manual: Use this option to manually define
Classification Code hierarchy. When record is
added, it will not be automatically classified. You
have to click on the open link to open to classify
record in the Classification Code editor and
define the Classification Code.

Automatic: Use this option to create
Classification Code hierarchy automatically
based on repository attribute hierarchy. When
the Classification Scheme type
AttributeMapping is selected and extraction
type is Automatic, the Classification Scheme
Attribute section is displayed and you must
map the repository defined attributes for each
hierarchical position. As attribute definition
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Field Description

defines how and where to extract data for
forming category hierarchy as well as classifying
record.

Mixed: Use this option if you want to first
classify the records using Automatic extraction
type and later on use the Manual extraction
type to classify the record manually. On
selecting the Mixed extraction type, the
Classification Scheme Logical Level section is
followed by the Classification Scheme Attribute
section.

Types Select the classification type from the drop-
down. The available options are
AttributeMapping and Rulebase. This field is
enabled only for Automatic and Mixed
Classification Scheme.

AttributeMapping: The AttributeMapping type
classification scheme support all the three
extraction types Automatic, Manual and Mixed.

Rulebase: The Rulebase classification type
supports Automatic and Mixed extraction types.
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Field Description

Use Predefined Select the Use Predefined check box to select
the predefined classification scheme.

The Name field is enabled and all the other field
are read-only. The available options are GPC and
UDEX.

If you select Use Predefined checkbox,
classification attributes are added to the
repository as per GPC or UDEX.

Select the predefined classification schemes
which you want to associate with repository
from the available options and click Finish.
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Field Description

The Classification Scheme Editor is displayed
with predefined classification scheme.

3. Click Next.

l On selecting the Manual, Mixed or Automatic extraction types, Classification
Scheme Logical Levels dialog box is displayed.
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l Define the logical level for the Classification Scheme. Click to add a logical

level. It is mandatory to create minimum one logical level.

l On selecting the Automatic and Mixed extraction types and type as Attribute
Mapping, the Classification Scheme Attributes dialog box is displayed and if
Rulebase type is selected then Rulebase selection page displayed.
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l Click to add the repository defined attributes for each hierarchical position

and click Finish.

4. On selecting the Automatic and Mixed extraction types and type as Attribute
Mapping, the Classification Scheme Attributes dialog box is displayed and if
Rulebase type is selected then Rulebase selection page displayed and click Finish.

5. The Classification Scheme Editor is displayed. The classification scheme editor is
displayed for manual, mixed and automatic Classification extraction types.
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6. Using the Classification Scheme Editor you can create the classification code
hierarchy. For more information on creating Classification Code refer to Creating
Classification Code Hierarchy.

Using Classification Scheme Property Section

Procedure
1. Select the Repository for which you want to create the Classification Scheme and

click the Classification Schemes tab.
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2. The editable table with the classification parameters is displayed. Click to add

new classification scheme. Enter the appropriate Classification Scheme name in the
Name column.

3. Enter the appropriate description for the Classification Scheme in the Description
column.

4. Select the appropriate extraction type from the drop-down. The available options are
Manual, Automatic, and Mixed.

l Manual: The manual extraction type supports Classification Scheme Logical
Levels.

l Automatic/Mixed: The automatic and mixed extraction types supports
Classification Scheme logical levels and Classification Scheme attribute sections.

5. Select the classification type from the drop-down. The available options are
AttributeMapping and Rulebase.

l AttributeMapping: The attributemapping type classification scheme support all
the three extraction types Automatic, Manual and Mixed.

l Rulebase: This Rulebase classification type supports automatic and mixed
extraction type. On selecting the Rulebase classification type, click the Browse
button and select the already defined rulebase. The selected rulebase is
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displayed.

6. Create the Classification Scheme Attributes. Click to create Category Specific

Attributes. By default, the Hierarchical position of the Classification Attribute are
displayed. Select the Category Specific Attribute from the drop-down list.

7. Create the Classification Scheme Logical Levels. Click to create logical levels. By

default, the logical levels and Logical Level names are displayed. You can modify the
Logical level names.



TIBCO® MDM Studio Repository Designer User Guide

106 | Classification Scheme Editor

8. To delete the attributes select the attributes and click .

9. Click Save.

10. Click <open..> in the Open Editor column. The newly created Classification Scheme
is displayed in the Classification Scheme Editor. The Classification Scheme Editor is
displayed on click open link.

11. Using the Classification Scheme Editor you can create the classification code
hierarchy. For more information on creating Classification Code, refer to Creating
Classification Code Hierarchy.
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Deleting Classification Scheme

Procedure
1. On Project Explorer, select the Classification Scheme and click .

Classification Scheme Editor
The Classification Scheme is divided in three section:

l Category Code Editor

l Linking/Unlinking Category Specific Attribute section

l Property Section

The Category Code Editor allows
l Adding child and sibling Classification Code.

l Importing of the Classification Code hierarchy from a CSV file.

l Inline editing of the Classification Code name on the tree node and Classification
Code Property section allows editing of the code, name, and description.

l Linking and unlinking of Category Specific Attributes to Classification Code.

l Browsing and searching of Classification Code within the tree based on the name.

l Viewing of attached attributes and the inherited attributes.

Creating Classification Code Hierarchy
Using Classification Code tree controls you can create Classification Code Hierarchy.
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Tree Controls

Editing Controls

Create a new child Classification Code.

Create a new sibling Classification Code.

Delete a Classification Code.

Navigating Controls

Refresh the Classification Code.

Expand to view all the Classification Code.

Collapse all the Classification Code.

Home Classification Code. If you are inside a
child or sibling Classification Code and want
to return the main Classification Code.

Back Classification Code. If you are inside a
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child or sibling Classification Code click and
want to return back.

GoInto Classification Code if you want view
the child or sibling Classification Code.

Procedure
1. Click to add a child Classification Code. Enter an appropriate name for the child

Classification Code.

2. The properties for child Classification Code are displayed. Enter the Code, Name, and
Description in the respective fields. You can add multiple child Classification Code.

3. Similarly click to add sibling Classification Code. Enter the Code, Name, and

Description in the respective fields. You can create multiple siblings of an existing
child.

4. Use the tree controls specified in the control table to Expand, Collapse, GoInto and
so on.

5. The newly created Classification Code is displayed.
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Editing Classification Code

Procedure
1. Select the Classification Code which you want to edit.

2. Double-click on the Classification Code name or use the F2 key. The inline text edit
control allows you to modify the Classification Code name.
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Dragging and Dropping of Classification Code
Hierarchy
You can drag & drop the select Classification Codes to a Classification Code node in the
tree.

Procedure
1. Select the Classification Code which you want to drag from the existing hierarchy and

drop it to the target Classification Code. For example, drag the
Food/Beverage/Tobacco Variety Packs Classification Code and drop it to another
Classification Code.

Note: You cannot drag a parent node on the child node. If done,
occasionally the dragged items become invisible. To restore the hierarchy,
click

.

2. Drop the Food/Beverage/Tobacco Variety Packs under the Beverages Classification
Code. The whole branch is removed from the existing hierarchy and dragged
hierarchy is formed under the target Classification Code.
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Browsing Classification Code hierarchy
If you have many Classification Code, navigating the Classification Code is made easy by
browsing a section of the Classification Code. Only the selected section or branch of the
Classification Code is displayed.

Procedure
1. Select the Classification Code which you want to browse. For example, select

Fruits/Vegetables/Nuts/Seeds Prepared/Processed Classification Code and right-
click. You can also use the navigation controls on the tree control panel to navigate
the Classification Code Hierarchy.

2. Select Go Into from the right menu. Only the selected branch is displayed.
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Viewing Inherited Classification Code Attributes
You can view the inherited Classification Code attributes. The Shown Inherit Attribute
check box allows to inherit all the Classification Code Attributes of its parent Classification
Code.

Procedure
1. Select the Classification Code for which you want to view the inherited Classification

Code. For example, select Alcoholic Cordials/Syrups the inherited Classification
Code is displayed.

2. Select the check box corresponding to Shown Inherited Attributed. The inherited
attributes along with list Category Specific Attributes associated with the
Classification Code (Food/Beverages/Tobacco) is displayed. The inherited attribute is
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displayed in the Attribute column and you can see the inheritedFrom column to
ascertain from where the attribute is inherited.

Searching Classification Code Hierarchy
You can search for a Classification Code using the pattern matching string as the search
criteria.

Procedure
1. Type the pattern matching string in the search field. For example, on typing *M

displays Classification Code names starting with anything and having a letter M.

2. To clear the search criteria click .
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Linking Category Specific Attributes with
Classification Code
Using this option you can link defined Category Specific Attributes to category code.

Procedure
1. Select the Category to link the attributes.

2. Select the Classification Code to which you want to link the Category Specific
Attribute. The table displays only the Category Specific Attributes, normal attributes
are not displayed in the table.

3. In the Attributes not linked section, select All from the Attribute Group drop-down.
This is used as a filter, all the Category Specific Attributes in the repository are
displayed.

4. Search for the category specific attribute by specifying the pattern based search in
the Search field. For example, if you type "Toba" in the search field all the attributes
containing the text "Toba" is displayed.
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5. Select the Category Specific Attribute and click .

6. You can select one or more than one CSA attributes to link. For example, Tobacco
Category Specific Attribute is linked to Food/Beverages/Tobacco Classification Code.
Continue to search for the categories and link it the Classification Code.

Unlinking Category Specific Attributes from
Classification Code
Using this option you can unlink the Category Specific Attributes from the Classification
Code.

Procedure
1. Select the Category to unlink the Category Specific Attribute.
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2. Select the Classification Code from which you want to unlink the Category Specific
Attribute. For example, Tobacco Category Specific Attribute is unlinked from
Food/Beverages/Tobacco Classification Code.

3. In the Attributes linked to Category section, the Category Specific Attributes linked
to Classification Code is displayed.

4. Select the Category Specific Attribute and click .

5. You can select one or more than one CSA attributes to unlink. You cannot unlink
inherited attributes, you have to select the inherited Classification Code and remove
the Linked Attribute.
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6. The unlinked Category Specific Attribute is removed from the Attributes > linked to
Category section. The unlinked Category Specific Attribute is displayed in table in the
Attribute not linked.

Importing Classification Code Hierarchy
In addition to creating the Classification Code using the Classification Scheme tree control,
you can also import the existing Classification Code hierarchy from the CSV files into the
Classification Scheme.

The CSV file format should contain the hierarchy level along with their code and
description. The CSV file should be of specific format. The headers should be grouped as
Columnsets. The columnset can have a value either 2 or 3. For example, code name desc or
code, name. The Classification-code hierarchy is defined by adding the parent and child
relationship of the ClassificationCode in the CSV file specified as a columnset. The
Classification-code attribute can be specified after the Classification-code columns e.g.
code1, name1, desc1, code2, name2, desc2, attributeName.

Below is a sample CSV format with column set as 2.
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Procedure
1. Right-click the newly created Classification Scheme, select Import > Import >

Classification Code.

2. The CSV file import Wizard is displayed.



TIBCO® MDM Studio Repository Designer User Guide

120 | Classification Scheme Editor

3. Click Browse to navigate to the path where you have saved the CSV file.

4. Define the ColumnSet field based on selected CSV column set definition.

5. Click Finish.

6. The Classification Code hierarchy is created. If the Classification Codes are already
present then they are merged.

Deploy Classification Scheme
The Classification Scheme are created for an existing repository model and contains all the
necessary information. When a repository model (.rep file) is deployed, all the
corresponding Classification Schemes in the repository are also deployed.

For more information on how to deploy Classification Scheme, see Deployment.
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Perspective Editor
This chapter introduces you to the new wizard for creating perspectives for a repository in
TIBCO MDM Studio and also allows you to deploy the perspective in the TIBCO MDM Server.

Perspective Editor Overview
In TIBCO MDM server, a repository may consists of large number of attributes, multiple
relationships defined with other repositories, and relationship attributes. However you may
be interested in only a subset of the attributes and the relationships to perform various
record operations. Navigating through the entire repository metadata is a significant
overhead and adversely affects the performance.

Using the TIBCO MDM Studio wizard you can define a subset of the attributes, the
relationship attributes and the relationships of a repository during the design time. This
subset view is called 'Perspective'.

Once the perspectives are defined for a repository, it is deployed to TIBCO MDM server. In
addition the perspectives are also saved to the database. The perspectives defined using
the TIBCO MDM Studio are viewed using the TIBCO MDM server User Interface. The records
and related records added to a repository are browsed based on the perspectives that are
defined for the repository.

Note: Perspectives will not be migrated or imported from older versions.
Perspectives must be recreated after migration.

Creating a Perspective
You can define a subset for the attributes , attribute groups, relationships, and relationship
attributes in the root repository or target repository.

Procedure



TIBCO® MDM Studio Repository Designer User Guide

122 | Perspective Editor

1. In the Project Explorer under the Repository model file, Right-click the Repository on
which user want to create a perspective and select New-- > Perspective.

2. The Perspective Generator Wizard is displayed.

3. Enter the Perspective name in the Name field and enter the description in the
Description field.

4. Click Next.
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5. Select the relationships, attribute group or the individual attributes, or relationship
attributes which you want to view in the perspective.

6. Click Finish.

7. The Perspective Editor with the newly defined perspective is displayed.
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8. The Perspective Editor displays the tree representation of the perspective. The tree
representation is not only accurate representation of your selection of the attributes,
relationship attributes and the relationships but also provides better and more
effective way of editing the perspective metadata after creating the perspective.

9. In the Properties section of the Repository model all the defined perspectives are
displayed.

10. Click the perspective link to view the perspective in the Perspective Editor.

Deploying a Perspective
The perspectives are created for an existing repository model and contains all the
necessary information. When a repository model (.rep file) is deployed, all the
corresponding perspectives in the repository are also deployed.

In addition, a set of selected perspectives can also be deployed individually by incremental
deployment. For more information on how to deploy perspective see, Deployment.
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Resource Bundle
A new editor is added to customize the resource bundle in TIBCO MDM Studio. After
customizing the resource bundle, it is deployed in TIBCO MDM Server.

Resource Bundle Overview
TIBCO MDM supports multiple locale resource bundles. There are five resource bundles to
localize or externalize the text within different components.

l htmlresources.properties: Resource bundle that contains static strings from all HTML
pages in the UTF-8 format.

l jsresources.properties: Resource bundle that contains strings from JavaScript files
and the JavaScript section of the HTML files.

l SharedDBStringResources.properties: Resource bundle that contains user interface
strings from selected tables of the database.

l SharedStringResources.properties: Resource bundle that contains:

o Display text of all menu items

o All retailer or supplier terminologies

o Descriptions and variable names defined in business process rules, rulebase
and workflows

o Any generic text displayed on UI

o User-specified text which needs translation and is displayed on UI

l UserText.properties: Resource bundle that contains dynamically created
informational, error, or warning messages displayed on the user interface.

All the default resource bundles are bundled within the ECM.ear in ECMClasses.jar file. The
resource values can be customized by overriding the default resource value. You must
create a new custom*.properties file and copy it under $MQ_HOME/custom/resource folder
for WebLogic and WebSpehere and for JBoss copy it under JBOSS_
HOME\\modules\com\tibco\mdm\main\com\tibco\mdm\properties\mdm.
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Since user on the cloud do not have access to the TIBCO MDM Server, it is difficult to
deploy the customizations. Hence a new editor to customized resource files is supported in
TIBCO MDM Studio. After customization, the resource bundle is deployed on the server.

Limitations

The following are the limitations of resource bundle:

l Java Script is not supported for hot deployment.

l It is recommended to restart the server after deployment the resource bundle for the
first time.

l All common resources (like login page, reset password) for all enterprises must be
deployed at application level .

Resource Bundle Editor
The resource bundle editor is divided into two section, one with list of resource bundle in
tabular format in key-value pair and another the property section for the properties of each
resource bundle.

You can perform various functions like:

l Customize a resource bundle

l Search by value or key

l Filter
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Customize
To customize the resource bundle, select the property you want to customize. The details
of the selected property is displayed in the Properties section.

Procedure
1. The Key field displays the selected properties key. It is a noneditable field.

2. The default value associated with the key is displayed in the Default value field. This
is a noneditable field.

3. Enter the customized value for the selected property in the Customized Value field
in the Property Section. Alternatively, you can also double click the Value field in the
table and enter the custom value in the Value field.
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Search
The resource bundle can be searched based on the key or value.

Procedure
1. Select the appropriate Search by option. The available options are Value and Key.

2. Specify the search criteria in the Search field. For example, you can search for a key
containing the word "close" by specifying the text "close" in Search field with Search
by criteria as Value.
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Filter
To filter, perform the following:

Procedure
1. To filter the resource based on the customized resource list or all resources, click

.

2. By default "All Default Resource" is displayed. To display "Custom Resources" click
the second filter icon. It displays only the custom resource. For example, the default
value "Modify" is customized to "modify" in the value field. Similarly to display "All
Custom and Model Resources" click the third filter icon.
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Note: The model resource is the new key or the repository model
customization which is done using the Resource Model Bundle Editor .

Creating a Resource Bundle
Using this option, you can create a resource bundle.

Procedure
1. In the Project Explorer under the Repository model file, Right click on Resource

Bundle on which user want to create a resource bundle and select New > Resource
Bundle Model.
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2. The Resource Bundle Model Wizard is displayed.
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3. Enter the Resource bundle name in the File name field and click Next.

4. The New Resource Bundle wizard displays the bundle type.
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5. Select the Locale, Bundle Type from the drop-down list. Select Import file from
server checkbox if you want to import the resource file from the TIBCO MDM server.
For the first time you need to select the import file from server checkbox.

6. If you select the Import file from server checkbox, the Select the server to load
properties file section is displayed.

l Select the Download custom resource checkbox if you have already deployed
the custom resource and you want to import the custom resource for
customization. For more information on download custom resource refer to
Download Custom Resource.

l All the available connected TIBCO MDM servers are displayed in the Select
Server drop-down list. Select the appropriate server. For more information on
creating a new server refer to Creating a MDM Deployment Server.

Creating-a-MDM-Deplo.htm
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7. Click Finish. The Resource Bundle editor with the newly created resource bundle is
displayed. After clicking finish button custom resources will be downloaded for the
selected locale, bundle type from the enterprise selected.
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Download Custom Resource
The download custom resource is used to customized the custom resources which is
already deployed.

Procedure
1. Select the Download Custom resource checkbox.
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2. On selecting the download custom resources checkbox then Enterprise Selection
option is displayed. The available option are standard and <your enterprise>. Select
the standard option if you want to download from application level or select <your
enterprise> for example, techpubs. By default the standard enterprise is selected.

3. Click Finish. The resource bundle editor with the custom resource is imported for
customization.

Resource Model Bundle Editor
The Resource bundle editor is used to add new keys for all resource types.
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Repository Model File for Generating Resource Keys
In case of Shared String resource bundle, the Resource Model bundle editor is used to
customize the repository model.

Procedure
1. Click on the Resource Model Bundle Editor tab, the editor with the various sections

is displayed.

2. Click .

3. The Repository model Selection Dialog is displayed.

4. From the Select Repository Model File drop-down list, select the repository model
file for which you want to generate the keys.
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5. Click OK.

6. The keys are generated for the repository, attribute groups and attributes names and
descriptions.

Customizing an Existing Properties from Model file
Each of the existing properties can be customized.

Procedure
1. Select the property you want to customize from the left tree panel.

2. To search for a property, type the property name in the type filter text field.

3. The default value of the properties is displayed in the Default Value field.

4. Enter the customized value in the Custom Value field. For example, for RAD__
CUSTOMER__FIRSTNAME key the custom value is "firstname". For more information
on the standards to provide customization keys, refer to TIBCO MDM Customization
Guide.

5. Save the customized value. The newly created customized value overrides the default
value.
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Adding a New Resource Property to the Model file
Any number of new property keys can be added.

Procedure
1. Type the complete resource key string in the text box below the left tree panel. The

add key button is enabled.

2. Click .

The new property key is added to the resource list.

3. Enter the custom value in the Custom Value field. The default value for the newly
added resource key would be empty.

4. The resource key string cannot be empty or does not allow white spaces. You can
enter only alphanumeric and underscores. You cannot enter duplicate keys. On
entering a key which is already present in the resource list ,the Add Key button is
disable and an error message "Key with this name is already present. Duplicate keys
are not allowed " is displayed.

Exporting a Resource Bundle
Using Export Wizard you can export the Resource Bundle.

Procedure
1. Right-click on the Resource Bundle folder in the Project Explorer and click Export--

> Export.
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2. The Export Wizard is displayed. Expand MDM Resource Designer from export
destination list, select MDM Resource Format and click Next.



TIBCO® MDM Studio Repository Designer User Guide

141 | Resource Bundle

3. Select the resource bundle which you want to export. By default resource bundle is
exported to Exports/MDMExportFolder directory which is in same project. You can
change the location by specifying different destination path. Click Path and browse
to the folder in which you want to export the resource bundle file and click Finish.
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Note: For more information on resource bundle, refer to TIBCO MDM
Customization Guide.

Deploying the Custom Resource Bundle
The customized resource bundle is deployed at the enterprise level or for the entire
application.

Procedure
1. Select the custom resource bundle to deploy from selected module.

2. Select the enterprise to which you want to deploy from Enterprise Selection
section. On selecting the ’Standard' enterprise, the custom bundle is deployed at the
application level.

3. Click Finish.
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Note: Hot deployment is supported for all type of resource bundle except
Java Script.
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Repository Model Report
The TIBCO MDM Studio model is used to develop a physical model for the TIBCO MDM
Server.

The TIBCO MDM server defines sophisticated models, which is difficult to interpret without
the TIBCO MDM Studio. The new Repository Report feature can be used by all stakeholders
in the various design phase of the models. The Repository Report will make the model easy
to understand and thereby help different stakeholders contribute in the design process.

Creating a Repository Model Report
Using this option, you can create a repository model report.

Procedure
1. In the Project Explorer under the Repository model file, Right click on Repository

Model and select Export-- > Export.
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2. The Export Repository Model Documentation wizard is displayed.
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3. Expand the MDM Repository Designer folder and select Repository Model Report.

4. Click Next.

5. The Repository selection page is displayed on Export Documentation wizard.
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6. Select the checkbox corresponding to the repository for which you want to generated
the model report. For example, b2b-Advanced-metadata.rep is selected from the
Party Model.

7. Click Finish. By default, the report will be save in the Exports/MDMReportFolder
under current Project directory. If you want to change the default location, select the
Path option and browse to the absolute path where you want to save the report
artifacts.

8. To view the Repository Model artifacts, expand the Exports folder. All the supporting
files are stored in the MDMReportFolder.
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9. The supporting images for the Index page (For example, b2b-Advanced-
metadata.html)is stored in the images folder and all supporting html files are stored
in the Repository Models folder.

10. For each repository model separate folder is created in a Repository Models folder.
The files folder contains all supporting .html files. In files folder, all Model and
Repository images are stored in the images folder. In style folder, all .CSS files are
stored.

Viewing Repository Model Report
The Repository Model Report displays all the repository for which the report is generated.

You can view the Repositories, Repository Model information, Repository details, Attribute
Groups details, Input Map details, Output Map details, Classification Scheme details,
Relationship and Relationship attribute group details, and Perspective details.

Note: For better viewing, you can view the Repository Model Report in an
external browser.
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Index Page
The Repository Model Index page displays the model design for each of the repository. You
can access the details of the report by clicking the model designs.

Procedure
1. Select the <RepositoryModelIndex.html file and open it in a web browser. The

selected <RepositoryModelIndex.html index page opens on the right hand side.

2. The index page comprised of the model design, model name, description, change
date, and the author of the report.

Repository Model Report
The Repository Model report shows the summary of the various parameters in the
repository.

The summary mainly comprises of counts of repositories, repository attribute groups,
repository attributes, relationships, relationship attribute groups, relationship attributes,
inputmaps, outputmaps, and classification schemes.
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Procedure
1. You can view the complete list of repositories, relationships in a tree view by clicking

.

2. The complete list of repositories, relationship and other components of the
repository are displayed.

3. You can also expand the tree view by clicking .

4. To collapse the tree view click .

5. To go back to index page click .

6. Click the repository, relationship and so on to view their details.
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Repository Model Information
The Repository Model image displays the complete repository information in the report.

All the repositories, relationships in the repository model are visible in the report. To view
the complete report, click on the Repository Model Image and the new window opens,
maximize the new window to view more details.

Repository Details
The Repository Details report displays the Repository name, its Display Name, Description,
Table Name and all Attribute Groups name from the repository. On clicking the link for
each attribute group, their respective attributes along with their parameters are displayed.
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Note: All blue names indicate links to that particular section.

Attributes Group Details
The Attribute Group details report displays all the attribute groups available in the
repository. Expand each of the attribute group to view their attribute details.
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Input Map Details with Input Mappings
Input Map and Input Mapping report displays Input Map name, Description, Source ID, the
Data Source Name associated with it, the Related Input Map, and Linked Relationships.
Input Map mapping is displayed along with Source expression.

Note: All blue names indicate links to that particular section.

Output Map Details with Output Mappings
The Output Map and Output Mapping report displays Output Map Name, Description,
Repository Name for which this output map is created, Related Output Map and
Relationship, Classification Scheme and Sync Format associated with the output map.
Output Map mapping along with source expression is displayed.
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Note: All blue names indicate links to that particular section.

Classification Schemes Details
The Classification Scheme details report displays Classification Scheme name, Description,
Extraction Type, Classification Type, Attribute which participated in category creation if it is
an Automatic or Mixed extraction type classification scheme, and Logical Levels in this
Classification Scheme.
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Note: All blue names indicate links to that particular section.

Relationships and Relationship Attribute Group
The Relationship and the Relationship Attribute Group details report displays Relationship
name, Description, Reverse Relationship Name, Reverse Relationship Description, Source
and Target repository name on which this relationship is created, the source and target
multiplicity. The relationship attribute group details are also displayed.

Note: All blue names indicate links to that particular section.

Perspectives Details with selected Repositories and
Relationships
The Perspective Details report displays Perspective Name, Description, Repository Name on
which the perspective is created, all the attribute in the perspective, and all the perspective
relationships.

For each of the perspective relationship section Relationship Name, direction of the
relationship (whether it is forward or backward), Perspective Name, Relationship attributes,
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Parent Relationship names, Target Repository Name, Target Repository attributes selected
for perspective, and Next level Perspective Relationships are also displayed.

Note: All blue names indicate links to that particular section.

Customizing the Repository Model Report

The Repository Model report can be customized to change the colors and font of the
report.

The repository model report can be used to customize the following:

l Default font

l Image

l Table header color

l Table left column

l Table header font color

l Attribute group name color

l Image layout in the Repository section

Customizing the Repository Model Report

To customize the report model report, perform the following:
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1. From Window menu, click Preferences.

2. Click on Repository Designer->Report Design.

3. Click Change to select the font.

4. The Font window displays, select the appropriate font, font size, and font style and
click OK.

5. To change the Image, click Browse and navigate to the new image in your window
open dialog box and click Open. The path of the new image is displayed in the Image
Location field.

6. Click the button corresponding to the Table Header Color, a new color window
opens, select the new color and click OK.

7. Click the button corresponding to the Table Left Column, a new color window
opens, select the new color and click OK.

8. Click the button corresponding to the Table Header Font Color, a new color window
opens, select the new color and click OK.

9. Click the button corresponding to the Attribute Group Name Color, a new color
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window opens, select the new color and click OK.

10. Select the appropriate radio option from the Repository Image Layout. The
available options are Left Alignment, Right Alignment, Center Alignment.

11. Click Apply.

12. Click OK.
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Input Map Editor
Input Maps are used to import a large amount of data from external sources. Input Map
uses data sources as primary input and allow you to map the data source attributes to
repository attributes. You can join more than one data source to map all or some of the
repository attributes. You can define an expression for a mapping, to import the data.

Input Maps
A repository can have more than one input map and can use same or distinct data sources
for defining mappings. The Input map name is unique for a repository.

Input Map can also have relationships across the repositories or in the same repository. For
input maps to be related, you must predefine the relationships between the repositories.
During import, related input maps (across repositories) can be used to map data to more
than one repository by selecting the respective relationship names while creating the input
map.

The Input Map Editor has multi tab editor. The each tab has the mapping for a specific
attribute group in a repository. The first tab always has all the attribute groups and their
mappings. In addition a filter is added to the Input map tree to search a repository
attribute. The search supports wild card search entries.

Input Map is enhanced to provide flexibility to add/removed category attributes. Once all
repository attributes are automatically added to input map, you can either add new
category attributes or remove category attributes in the input map definition.

In addition you can also select the Classification Scheme and link the classification code
with the category specific attributes. However, only Manual extraction mode is supported.

Creating Input Map
You can create input maps within or across repositories.
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Procedure
1. In the Project Explorer window under Repository Models, right-click a repository on

which you want to define the input map and select New > Input Map.

The Input Map wizard is displayed.

2. In the Input Map wizard fields, enter the relevant details.
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Field Description

Root Repository The name of the repository for which you want
to create the input map is displayed.

Input Map Name Enter the Input Map name. The Name is unique
and case insensitive for a input map. The name

The following table lists the fields and their description:
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Field Description

can contain A-Z, 0-9 and _.

Description The description for the Input Map.

Source ID Specify a Source ID. The source ID allows you to
associate the data with an external system. The
source ID can used in workflow and business
process rules to customize business processes.

Approval Option Select one of the following approval options:

l Split/Approval Required: When you
select this option, the records are split
into batches before processing, but the
system waits for an approval before
confirming changes for each record
bundle. Conflicts, if any, must be resolved
for each record bundle separately.

l Split/No Approval: If you select this
option, the records are split into batches
before processing, but the system
continues to process the record bundles
without waiting for a confirmation.
Conflicts, if any, must be resolved for each
record bundle separately. The bundle is
saved as a confirmed record, without
initiating any approval workflows.

l Direct Load: If you select this option, all
records are processed in one go in
multiple bundles and no events are
created for each bundle. Changes are
confirmed without approval. In case of
conflicts, imported data take precedence
and the conflict must be resolved
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Field Description

separately.

l Database Loader: If you select this
option, the records are uploaded using the
Database Loader.

l Big Data Import: If you select this option,
all records are processed in the Apache
Spark cluster without any workflow.

Big data import feature has a few
limitations. For information, see TIBCO
MDM User Guide.

Important:

o To use the Big Data Import
option, you must have installed
and configured Apache Spark
and Apache Hadoop File
Distributed System. For
configuration, see TIBCO MDM
Installation and Configuration
Guide.

o To use the big data import
feature through TIBCO MDM UI,
see TIBCO MDM User Guide.

Merge Data Select the Merge Data check box. When
checked, it indicates that any previous child
relationships must be retained. By default,
Merge Data check box is selected on New Input
Map wizard.

Incremental Select the Incremental check box if you want to
include only new data or make changes to the
existing data. By default, Incremental check box
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Field Description

is selected on New Input Map wizard.

Direct Load Options If you select Direct Load Approval option then
Direct Load Options is displayed.

l Import Relationships Only: If you select
this check box, relationships are created
for existing records.

l Delete Relationships Only: If you select
this check box, relationships between
records are deleted for existing records.

l Classify Records Only: If you select this
check box, classification records are
created for existing records.

Fresh Data/ Mode If you select Database Loader Approval option
then Freshdata and Mode option is displayed.

l Freshdata: If you select this option, it
indicates data is clean and initial version
records need to be imported.

l Mode: If you select this option, it displays
Load Records and Load Relationships in
the drop-down list. Select Load Records to
load record data with relationship.
Similarly select Load Relationships to load
relationship between existing records.

3. Click Next.

The Datasource Selection wizard is displayed.

4. in the Select Data Source section, select a data source by selecting the check box
next to it.
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5. In the Primary column, select the check box if you want to define the data source as
primary data source.

6. Click Next.

The Select Relationships wizard is displayed.
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7. If you want to define cross-repository or self-relationship (related input map), select
the check box corresponding to the relationship name.

8. Click Next.

The Select Classifications wizard is displayed.
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9. If you want to include classification scheme, select the check box corresponding to
the classification scheme.

Note: You can select the Classification Scheme for only for Manual
extraction type.

10. Click Finish.

The Input map is created and displayed in the Input Map editor.

If the input map is created by selecting relationships, the related input maps are
created under the related repositories. Similarly, if the input map is created by
selecting classification scheme, the category specific attributes are displayed in the
Input Map editor.
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Input Map Editor

The Input Map editor displays the newly created Input Map. It also displays the Input Map
properties in Properties tab. The Input Map editor is enhanced to display the following:

l The Input Map Editor is partitioned into multiple tabs, each tab contains mapping for
a specific attribute group.

l The Classification Scheme is included in the Input map Editor.

l Allows include and exclude of Category Specific Attributes.

l Allows searching of attribute using the text search filter.
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Input Map Controls

Repository Model of the input map.

Expand All the attributes groups in the input
map.

Collapse All the attributes groups in the input
map.

Add Category Attribute.
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Remove Category Attribute.

Show Mapped.

Show Unmapped.

Show All Mapping.

Input Map Property Section
The Input Map properties can be viewed and modified using the Input Map property view.
The Inputmap properties section comprises of the General and Advanced tab.

General Tab
All the information in the Inputmap section is described in the general tab.

You can update the Input Map Name, Description and Approval Option. Similarly you can
also update the Merge Data and Incremental parameters. Select the Null If Blank check
box if you want to consider a blank value. Select the Import Relationship Only check box
if you want to create relationships for existing records. Select the Delete Relationship
Only check box if you want to delete the relationships for existing records. Select the
Classify Records Only check box if you want to create classification records for existing
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records. If you have more than one data sources for the input map, you can select
Common Keys columns between the data sources.

Advanced Tab - Basic
An advanced property tab is used to define the order by attributes. The advanced property
tab is visible only for the root input map and is not supported for related and classification
input maps.

Procedure
1. In the Basic mode, the left side list displays all the mapped attributes in input map.

Select the attribute and click .

2. In addition a Search filter is also provided for quick search of attribute. The selected
attributes are displayed in the Order By Attributes table.

Note: The multi-valued attributes are not supported for order by.

3. Specify the sort order from the Sort Order column. The available options are ASC
(ascending) and DSC (descending).

4. Select the attribute and click to remove the attribute from the order by attributes

table. You change the order of the attributes by clicking the and .
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Advanced Tab - Advanced
On the Advanced tab, you can define the exact Order By expression to be used during
record import. The expression must be a valid Order By expression and is specific to a
database.

In the staging table of TIBCO MDM, all attributes are of the type string, the data type
conversion must be handled in the Order By expression. The data type conversion may
vary for different type of databases. For example in case of Oracle database, TO_TIMESTAMP
(CATTRA_TIMESTAMP,yyyy-MM-dd HH24:MI:SS.FF) DESC.

Advanced Tab for Big Data Import

When creating an input map, if you have selected the Big Data Import approval option,
the Rulebase option is displayed on the Advanced tab.

Note: The Rulebase option is only supported for the input map with the Big
Data Import approval option.

Browse to select the rulebase that is defined for the parent repository and of type Other.
For information on creating a rulebase model and different types of rulebase types, see the
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"Creating a Rulebase Model" and "Actions Allowed for Different Types of Rulebases"
sections in TIBCO MDM Studio Rulebase Designer User Guide.

Creating an Input Map with a Cross-repository
Relationship
At times, there is a need to capture data spread across data sources into multiple logically
related repositories. To achieve this purpose, Input Maps of one repository can be related
to Input Maps of other repositories to distribute data across related repositories.

To relate input maps of any two repositories, it is essential that there exists a predefined
relationship between these repositories. Related input maps must be based on same or
subset of data sources selected and can be used or associated with other input maps.

Procedure
1. Right click on Repository name from the Input Map tree section on which you want

to include related repository and click on Add Input Map for Relationship.

2. Select relationship from the sub menu. A new related Input Map will be added in the
Input Map tree.
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3. Double click the related Input Map, it will open in an another editor.
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4. You can create a related Input map using an existing input map or create new input
map to link with the parent input map.
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5. If you have existing input maps in the related repository, select the Use Existing
Input Map option. When you select the Use Existing Input Map option, the drop-
down list displays the input maps available in the related repository. Select Create
New Input Map option to create a new input map for the related repository.

Classification Code Mapping

Procedure
1. Drag and drop the Data Source Attribute (Data Source Tree on the left side of the

editor) to Classification Scheme Logical Level.
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2. The classification code mapped to the Classification Scheme Logical Level is
displayed.

3. The property section of the classification scheme logical level displays the logical
levels specified during the Classification Scheme creation. Enter the expression for
the logical level.

Adding Category Attributes
By Default Category Specific Attributes are not listed in Input Map Editor. You can add an
existing Category Specific Attribute to the Input map Editor.

Procedure
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1. Open Input Map and click to add new category attributes.

2. Category attribute dialog box is displayed, select the checkbox corresponding to the
category attribute selection or search the category attribute using the pattern based
search. For example, *e.

3. Click OK.

4. The added category attributes are displayed in the selected input map.
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Removing Category Attributes
You can remove the category attributes from the input map.

Procedure
1. Select category attributes in the input map which you want to remove. Select the

category attribute which you want to delete.

2. Click to remove the selected category attributes from the input map.

3. The category attribute removed do not appear in the input map.
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Selecting Primary Data Source
If there are multiple data sources, you can identify a primary data source and define it as
Primary.

Procedure
1. In the Input Map Editor, select the data source which you want to define as Primary.

2. Right click on the data source name and click Primary Data Source.

Result

After selecting a particular data source as a primary data source, * will appear on the
primary data source.
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Primary data source identification is optional and is recommended only if there are more
than one data sources.

Defining Input Map Mapping

Procedure
1. To manually map the input map, Drag and drop the Data Source Attribute (Data

Source Tree on the left side of the editor) to Repository/Relationship Attribute (Input
Map Tree on the right side of the editor).
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2. To automatically map the input map, Right click on the Repository and click Auto
Map.

3. You can define multi-value attribute mapping in the input map editor. The multi-
value attribute is identified by .

4. Drag and drop the Data Source Attribute (Data Source Tree on the left side of the
editor) to multi-value Attribute (Input Map Tree on the right side of the editor).

Alternatively you can also define multi-value attribute mapping using the
property view. Select the multi-value attribute and click in the property
view to define the mapping. Enter the mapping expression in the text box.

5. To enter the source expression for the Repository/Relationship Attribute, Click on the
Attribute under Input Map tree (Right hand tree). The text editor will appear in the
property section.
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6. Select the Null If Blank check box if you want to consider a blank value in the data
source.

View Mapped Unmapped Mappings
To view all mapping (both mapped and unmapped attributes) click .

The attributes values are expanded and the mapping is displayed.
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To view only mapped attributes) click .

Only the mapped attributes are displayed.
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To view unmapped attributes) click .

All the unmapped attributes are displayed.

Deleting Mappings

Procedure
1. From the Input Map Editor, select the mapping which you want to delete.

2. Right click on the mapping and click Delete mappings.
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Result

Note: If repository attributes are used in a data source and input maps model
and if the attributes are either deleted from the repository model or moved from
one attribute group to another, then the mapping between data source
attributes and repository attributes will be deleted from the input map. Establish
the mapping once again if the attributes are moved from one group to another.

Adding Removing Data Source
A Data Source can be added or removed from the existing input map in the project. All the
data sources defined in project can be viewed from the Input Map Editor menu.

Procedure
1. From the Input Map Editor, select the Input Map to which you want to add or remove

a data source.

2. Click and point to Data Source and select the data source which you want to add
or clear the data source which you want to delete.
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Deleting Input Maps

Procedure
1. Right -click on the Input Map (Input Map Tree) which you want to delete and click

Delete Input Map.
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Deploy Input Map
When repository model is deployed associated input maps also get deployed. However
input map can also be deployed separately without deploying full model.

For more information on how to deploy Input Map see Deployment
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Output Maps
This chapter introduces how to design output maps between the attributes in the
repository, relationship attributes and the various outbound synchronization formats.

Output maps associate repository attributes with corresponding attributes in various
outbound synchronization formats.

In repository relationships, to synchronize data scattered across repositories, you can
create related output map by selecting the forward, self and reverse relationship. The
relationship select page is enhanced to populate the self and reverse relationships along
with the forward relationships.

Creating Output Map
Output maps can be created within the same repository or across repositories.

Procedure
1. In the Project Explorer under the Repository model file, Right click on Repository on

which user want to define the Output Map and select New-- > Output Map.

2. The Output Map Wizard is displayed.
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3. Enter a name and description for the Output Map. The Name is unique and case
insensitive and can contain A-Z, 0-9 and _.

4. Select the appropriate synchronization format from the Select Synchronization
Format drop-down list.

5. Select the User Predefined checkbox if you want to use the predefined output map.
For more information, refer Importing Predefined Output Map

6. Click Next. The Select Relationships screen is displayed.
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7. To support hierarchical all the immediate relationships of the repository (self
relationship, forward and backward relationships) are displayed. You can select
different or same sync formats for the relationships. Select the check box
corresponding to the relationship name and click Next.

8. The Select Classification Scheme for Output map screen is displayed.
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9. If you want to include classification scheme, select the check box corresponding to
the classification scheme and click Finish.

10. The output map is created and displayed in the Output Map editor. If the output map
is created by selecting forward, reverse, or self relationships then forward, reverse,
relationship output maps are created in separate tabs.

Importing Predefined Output Map

Procedure
1. In the Project Explorer, right click and select Import-- > Import.
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2. The import wizard is displayed. Select Import Predefined Outputmap Meta Data
from MDM Repository Designer and click Next.

3. The Predefined output map metadata import wizard is displayed. Click on Browse
and select the predefined output metadata file and click Finish.
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Associating Predefined Output Map with existing
Repository
To associate the predefined output map with existing repository, the predefined out map
must be imported into TIBCO MDM Studio. The same predefined output maps are
populated during association.

Procedure
1. In the Project Explorer under the Repository model file, Right click on Repository on

which user want to define the Output Map and select New-- > Output Map.
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2. The import wizard is displayed. Select the Use Predefined check box.

3. The predefined output map is populated in the Name field. Select the appropriate
predefined output map and click Finish.

4. The Output map is associated and displayed in the Output Map editor.
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Output Map Editor
The output map editor displays the newly created output Map. The output map editor
contains repository attributes on the left hand side and sync format attributes on the right
hand side shown as a tree. The type ahead filter is also provided for quick search. You can
add related output map from the editor.
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Creating a Related Output Map
You can create related output map for a forward, reverse, and self relationship from editor.
You can also create related output map from the wizard. If you are creating a related
output map on relationship and if the relationship has relationship attributes then for that
relationship attributes, relationship output map gets created.

Procedure
1. Right-click on the parent output map, point to Add Output Map for relationship.

The relationships available for parent output map are shown. When you select
relationship, available synchronization formats are displayed to associate with
related output map. For example, select the reverse relationship InsuranceDetails_
Vehicle_Bwd.

2. The output map for the reverse relationship is displayed.
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3. You can create a related output map using an existing output map or create new
output map to link with the parent output map. If you have existing output maps in
the related repository, select the Use Existing Output Map option. When you select
the Use Existing Output Map option, the drop-down list displays the output maps
available in the related repository. Select Create New Output Map option to create a
new output map for the related repository. The new output map name and
description is automatically generated with numeric suffix. Select the synchronization
format and click Create.

Note: To define a relationship between two output maps of any two
repositories, there must exist a relationship definition between those two
repositories.

4. You can rename the output map from the properties section. For example, you can
rename the related output to InsuranceDetails_Vehicle_Bwd_OutputMap1
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5. Since the related output map on a relationship has relationship attributes, then for
the relationship attributes, a relationship output map gets created.

6. If you rename the related output map, then the relationship output map is also
renamed. For example, you can rename the related output to VehicleToCustomer_
Fwd_OutputMap2 then the relationship output map also gets renamed to
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VehicleToCustomer_Fwd_OutputMap2_VehicleToCustomer_Fwd_relationship.

7. Similarly you can also create a related output for a self relationship.

Defining Output Map Mapping
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For Repository Attributes

Procedure
1. To manually map the output map, Drag and drop the Repository Attribute (Output

Map tree on the left side of the editor) to Synchronization format attributes (Sync
format tree on the right side of the editor).

2. To automatically map the output map, click .

3. To enter the source expression for the Repository attribute, click on the mapping.
The text expression editor will appear in the property section.
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4. Enter a valid SQL expression in the Expression text field. The rules applicable to an
expression entered are:

a. All expressions entered in the expression text field must be valid SQL
expressions.

b. If you include a column name from an SQL table, ensure that the name,
entered exists and is as specified in the SQL table.

c. For constant value mapping, enter integers directly, but embed String values in
single quotes (’<string’). For example, For Integer, CASE WHEN price > 50 THEN
50*3 ELSE price END. For String, CASE WHEN state = 'CONFIRMED' THEN 'CONF'
ELSE state END.

For Predefined System Attributes
To map predefined attributes, drag and drop the predefined attribute from System
attribute group displayed on left side tree to synchronization format attributes (Sync
format tree on the right side of the editor).
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To enter the source expression for the predefined system attribute, click on the mapping.
The text expression editor will appear in the property section.
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For Relationship Attributes

Procedure
1. To manually map the relationship attribute, open relationship output map tab and

drag and drop the relationship attribute (on the left side of the editor) to
Synchronization format attributes (on the right side of the editor).

2. To automatically map the output map, click .

3. To enter the source expression for the Relationship attribute, click on the mapping.
The text expression editor will appear in the property section.
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4. Enter a valid SQL expression in the Expression text field.

For Classification Scheme
To map classification scheme attributes, drag and drop the classification scheme attribute
on the left side of the editor to synchronization format attributes on the right side of the
editor.
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View Mapped Unmapped Mappings
To view all mapping (both mapped and unmapped attributes) click .

The attributes values are expanded and the mapping is displayed.
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To view only mapped attributes, click .

Only the mapped attributes are displayed.

To view unmapped attributes, click .

All the unmapped attributes are displayed.
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Deleting Mappings
To delete mapping from the existing output map.

Procedure
1. From the Output Map Editor, select the mapping which you want to delete. Right

click on the mapping and click .

View Category Hierarchy
To view the category Hierarchy, click and expand. The Category hierarchy along with the

belonging attributes are displayed..
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The Category Specific Attributes by default are hidden in the output map editor. Click the
check box corresponding to the Category Specific Attribute to control the visibility of a
particular Category Specific Attribute. To search for the Category Specific Attributes, specify
the attribute in the search field. When a Category Attribute is selected, the parent category
is also selected till the root level and all the inherited attributes are also selected. On
selection, the Category Specify Attribute is displayed in the output map editor.

Deleting Output Maps
If you delete the related output map having related relationship attributes, all associated
relationships with other output maps are deleted, but the parent output map in the related
repositories remains intact.

Similarly, when a repository is deleted, all the associated relationships, input maps, and
output maps across repositories are deleted.

Procedure
1. From the Output Map Editor, select the output Map from which you want to delete

and click on the top right corner of the editor or right click on the output map in

the project explorer and click
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.

Result

Note: If repository attributes are either deleted from the repository model or
moved from one attribute group to another, then the mapping between
synchronization format attributes and repository attributes will be deleted from
the output map. Establish the mapping once again if the attributes are moved
from one group to another.
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Working with PatternsIndexer Configuration
Editor
This chapter introduces you to the concept of PatternsIndexer Configuration in TIBCO MDM
Studio and explains how to create and deploy the PatternsIndexer Configuration using
PatternsIndexer Configuration Editor.

Overview
The PatternsIndexer Configuration allows you to define a new editor which is more
intuitive and takes advantage of the repository metadata to define attributes for Text-
indexing. The PatternsIndexer Editor allows to define the IndexEntity hierarchy. Some of
the features supported by PatternsIndexer Configuration Editor are as follows:

l Allows adding, editing of property section of the IndexEntity.

l Allows adding related repositories for defining join entities.

l Allows selecting more than one repository attributes for Text-indexing.

l Allows indexing and unindexing of attributes to IndexEntity and TargetRepository

l Allows filtering and searching within the tree based on the IndexEntity name

l Allows filtering the attributes that are not Indexed using the attribute group, name
and category specific flag.
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PatternIndexer Configuration Interface

Project Explorer: The project explorer displays all the folders available in the project. The
folder like the datasource, repository model, project’s configuration, rulebase models and
so on.

IndexerSpec Tree Control Toolbar: The IndexerSpec tree control toolbar displays the
toolbar icons for adding index entity, validating, deleting, re-ordering, refreshing,
expanding and collapsing the tree outline.

Tree Controls

Editing Controls

Create a new IndexEntity.

Validate the IndexEntity.
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Delete a IndexEntity.

Navigating Controls

Refresh the IndexEntity.

Expand to view all the IndexEntites.

Collapse all the IndexEntites.

Home IndexEntity. If you are inside a child
node IndexEntity and want to return the main
IndexEntity.

Back IndexEntity. If you are inside a child node
IndexEntity click the icon to return back.

GoInto IndexEntity if you want view the child
node IndexEntity.

IndexerSpec Tree Control: IndexerSpec Tree control shows the hierarchy of IndexEntities
created for the various repositories.

Attributes Selection Area: The attributes selection area helps is adding and removing
attributes for indexing.

PatternIndexer Properties: The property section displays the properties of the
IndexEntities.

Creating a PatternsIndexer Configuration
The PatternsIndexer Configuration is created using the PatternsIndexer Configuration
Wizard.

Procedure
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1. Select the Configurations folder and right- click on New >
PatternsIndexerConfiguration.

2. The Create Patterns Indexer Configuration wizard is displayed.
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3. Enter the patternsIndexer file name in File name field and click Next.

4. The Select Repository wizard for selecting the repository to index attributes is
displayed.
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Field Description

Name Name of the PatternsIndexer.

Repository Model Select the repository model from the drop-down
list. Ensure that you have repository model or
else create a repository model.

Repository The list of all the repository available in the
repository model is displayed. Select the
repository on which you want to create the
index.

5. Enter the IndexEntity name in the Name field.

6. Click Finish.

7. The PatternsIndexer Configuration Editor is displayed.
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8. Expand the IndexerSpec node. If IndexEntity is created without selecting a
repository, you can drag and drop a repository on to index entity directly. If no
IndexEnity is present you can create by clicking Create IndexEntity button on the tree
control toolbar.
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9. The newly created IndexEntity is displayed. The repository on which the indexer is
created is displayed inside the bracket. For example, CLIENT. Using the
PatternsIndexer Configuration Editor you can create the indexing attributes. For more
information on the PatternsIndexer Configuration editor refer to PatternsIndexer
Configuration Editor.

10. If there are multiple relationships selected for indexing, select the Normalize
checkbox in the Properties section. On selecting this option, the TIBCO Patterns-
Engine uses patterns join for searching the `term` across repositories.

PatternsIndexer Configuration Editor
The PatternsIndexer Configuration is divided in three section:

l Left hand side is the tree control to define IndexEntity hierarchy.

l Upper right hand side to shows the Indexed attributes selected for text indexing.

l Lower right hand side shows the UnIndexed attributes of the repository attributes.

The PatternsIndexer Configuration Editor allows:

l Adding IndexEntity.
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l Adding related repositories for defining join entities.

l Editing of IndexEntity name from the Property section.

l Indexing and un-indexing of attributes to IndexEntity and target repository.

l Filtering and searching within the IndexEntity tree based on the name,

l Filtering of attributes that are not Indexed using attribute group, name, and Category
Specific Attributes flag.

Creating IndexEntity
Using PatternsIndexer Configuration tree controls you can create new IndexEntities.

Procedure
1. Click to add a IndexEntity. The Create IndexEntity wizard is displayed.
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2. Enter the IndexEntity name in the Name field. Select the repository model from the
Repository Model drop-down list. Based on the repository model, the available
repositories will be displayed in the Repository drop-down list. Select the appropriate
repository. Repository selection and IndexEntity name are optional in the wizard.

3. Click OK. The newly created IndexEntity is displayed.

Defining Indexing Repository Attributes
Using this option you can select the repository attributes for text indexing.

Procedure
1. Select the IndexEntity in the Tree Control view, all the attributes associated with the

repository are displayed in Attributes not Indexed section.
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2. In the Attributes not Indexed section, select All from the Attribute Group drop-
down. This is used as a filter, all the attributes in the repository are displayed.

3. If you have category specific attributes in the repository, select the Category >
Specific check box, all the category specific attributes in the repository are displayed.

4. Search the attributes by specifying the pattern based search in the Search field. For
example, if you type "start" in the search field all the attributes containing the text
"start" is displayed.

5. Select the attribute and click .

6. You can select one or more attributes to index using the ctrl+mouse click.

7. You can either sort or reorder the indexed attributes. Both sorting and re-ordering
cannot be done together.

l To sort the indexed attributes, click the Attribute Name column, the attributes
are sorted in the ascending or descending order. The sorting feature is
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applicable only for the Attribute Name column.

l To reorder the indexed attribute, click any column (For example, Attribute
Group) other than the Attribute Name column. Select and drag the indexed
attributes to any position within the Attribute Group column.

l You can also sort after reordering the indexed attributes. To sort after
reordering, click the Attributes Name column. The attribute name is sorted and
the other column (Attribute Group) displays the reordered indexed attributes.

UnIndexing Repository Attributes
Using this option you can unindex the attributes from the selected repository.

Procedure
1. Select the IndexEntity from which you want to unindex the repository attributes. All

the attributes which are indexed are displayed.
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2. Select the repository attributes which you want to unindex. For example, Name
attribute and click .

3. You can select one or more attributes to unindex.

4. The unindexed attribute is removed from the Attributes linkedto
IndexEntity<Repository> section. The unindexed attribute is displayed in table in
the Attribute not Indexed.
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Dragging and Dropping of Repository on Index
Entity
You have an option to change the Repository by dragging a repository from the project
explorer on to the "IndexEntity" node of the PatternsIndexer Editors Tree Control.

Procedure
1. Click to add a IndexEntity. The Create IndexEntity wizard is displayed.

2. Click OK without entering the Name, Repository Model, and Repository fields.

3. The PatternsIndexer Configuration Editor is displayed.
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4. Expand the IndexerSpec node.
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5. The newly created IndexEntity is displayed. Since you did not select any repository
model, a blank IndexEntity is created.

6. From the explorer, select the repository for which you want to create index entities.
Drag and drop the repository on the IndexEntity node.

7. The repository name for which you have created the IndexEntity is displayed
alongside the IndexEntity. For example, PERSON. The Repository name is not editable
in the property section.

Adding Relationship (Target Repository) to
IndexEntity
You can join repositories by adding relationships to IndexEntity. You must select the
relationship from the parent repository to target repository.

Procedure
1. Select the IndexEntity and right-click the Add Relationship -<Relationship name> is

displayed. Only forward relationship name is listed.
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2. Select any relationship. The relationship is added to the IndexEntity.
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3. If there is no relationship is available to be added, the No Relationship Found
message is displayed instead of the relationship name.

4. Similarly if you have already added the relationship and are trying to add another
then Relationship Already Defined message is displayed.
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Delete IndexEntity
IndexEntity also has provision of deletion.

Select the IndexEntity or target repository (relationship name) which you want to delete
and on the Tree Outline Toolbar click .

Validate IndexEntity
The PatternsIndexer Configuration Editor uses the repositories from the .rep file. You can
change the repository or relationships parameters, any modification to the repository name
is directly reflected in the tree-control.

However, any deletion or addition of an attribute or a relationship or a repository is not
reflected. In order to sync-up the modification to the repository with the PatternsIndexer
Configuration Editor you must click .
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Modify the IndexEntity Properties
When you select the IndexEntity, the property-section associated with the IndexEntity is
displayed, you can edit the properties of the IndexEntity.

Field Description

Name Displays the name of the IndexEntity. You can
modify the IndexEntity name.

Project Name Displays the name of the project name associate
with the Repository. You can modify the project
name. This field is mandatory.

Repository Displays the name of the repository associated
with IndexEntity or TargetRepository. It is a non-
editable field.

Normalize Select the check box to normalize.

Searching Nodes in IndexConfig Hierarchy
You can search for a IndexEntity using the pattern matching string as the search criteria.

Type the pattern matching string in the search field. For example, on typing *C displays
IndexEntity names starting with anything and having a letter C.

To clear the search criteria click .
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Exporting IndexEntity
In addition to creating the IndexEntity, you can also export the PatternsIndexer. All the
IndexEntities defined in the PatternsIndexer Configuration is exported.

Procedure
1. Right click on the newly created PatternsIndexer Configuration, select Export >

Export.
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2. The Export Wizard for selecting the PatternsIndexer Configuration is displayed.
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3. Select MDM PatternsIndexer Configuration Format and click Next.

4. The MDM Data Source Export Wizard for selecting the data source model is displayed.
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5. Select the PatternsIndexer which you want to export. For example, PAC.idx and click
Finish.

6. The Project Export shows the exported PatternsIndexer file.
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Deploy PatternsIndexer Configuration
The PatternsIndexer Configuration is created for an existing repository model and contains
all the necessary information.

The Configurations folder is shown in the deployment wizard, you can select the
IndexerConfig file to deploy the artifacts to the TIBCO MDM Server.

For more information on how to deploy PatternsIndexer Configuration see Deployment.

After deploying the text indexer on TIBCO MDM server. The index file can be viewed from
$MQ_HOME\config\IndexerConfig.xml

Whenever a new IndexerConfig.xml is deployed, only the copy of the previous version is
maintained.

You can restore the IndexerConfig.xml from the backup location. Import of patterns
IndexConfig.xml file is not supported.

After deployment, the records are indexed only if the Patterns server is running.
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Working with CustomQuery Designer
This section talks about the Custom Query Configuration Model in TIBCO MDM Studio and
explains how to create and deploy the Custom Query Configuration usnig the Custom
Query Designer.

Overview
In TIBCO MDM Studio you can design custom query configuration and deploy it on the
TIBCO MDM server.

Using the Custom Query Configuration editor you can define a Custom Query. The intuitive
user interface of the editor takes advantage of the Pattern indexer config model file to
define the custom query model.

Custom Query Configuration Interface
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1. Configurations folder: All the Custom Query config files are available inside the
project's configuration folder.

2. Custom Query Toolbar: The Custom Query editor toolbar displays the toolbar items for
designing, deleting, reordering, refreshing, expanding, and collapsing the tree outline.

Tree Controls

Editing Controls

Create a Query Config or Querylet.

Delete a Query Config or Querylet.

Navigating Controls

Refresh the Custom Query model.

Expand to view all constituents of a Custom
Query Config.

Collapse all constituents of a Custom Query
Config.

Home. If you are inside a child node of a
Custom Query, click the icon to return the
main Custom Query.

Back. If you are inside a child node of a
Custom Query, click the icon to return back.

Go Into. Click this icon to view the child node
Custom Query.

3. Custom Query Tree Viewer: Contains defined Match Rules that are executed in
sequential order. If the first Match Rule does not find any match, the Match engine
executes the next match rule, and soon.
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4. Custom Query Properties: Panels 4 and 5 in the image above display the properties of
the Custom Query Config constituents (Query Config, Querylet, Query, and Match Case
rules).

You can also view a raw preview of the MatchRules or QueryConfiguration xml files.

Creating a Custom Query Model
You can create a Custom Query Model by using the Custom Query Creation wizard. Follow
these steps to create a Custom Query Model.

Before you begin
Ensure that the PatternsIndexer Configuration is created and all the artifacts are deployed
on the TIBCO MDM Server. For more information about PatternsIndexer Configuration, see
the Working with PatternsIndexer Configuration Editor section.

Procedure
1. In the Project Explorer, right click the Configurations folder and then select New >

Custom Query Config Model. The Create Custom Query Configuration wizard is
displayed.
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2. Enter or select a parent folder and provide a name for the Custom Query Config.
Ensure that the file extension is .cqc. Click Next. The Indexer Config Selection wizard
is displayed.
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To know more about the Indexer Configuration file, see the Creating a
PatternsIndexer Configuration section.

3. Select the Indexer Configuration file and click Finish. The Custom Query Model is
created and displayed in Custom Query Config editor.
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Adding a Query Config
Complete the following steps to add a Query Config.

Procedure
1. From the Project Explorer, navigate to Configurations > CustomQueryConfig.cqc.

The custom query config panel is displayed.

2. Click the icon to add a new query config. The Create Query Config dialog is

displayed.

3. Enter a Query Name and click OK. The new Query Config is added and displayed in
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the right side panel.

You can edit the Query Config name and file name in the right-side panel of the
Custom Query editor or from the Properties tab. Additionally, you can specify
parameters specific to Custom Query Config under Properties > General >
Parameters.

Adding a Querylet
Complete the following steps to add a Querylet.

Procedure
1. From the Project Explorer, navigate to Configurations > CustomQueryConfig.cqc.

The custom query config panel is displayed.

2. Select a query config and then click the icon to add a new Querylet. The Create

Querylet Config dialog box is displayed.

3. Enter a Querylet Name and click OK. The Query section is displayed on the right side
where you can build your query function.
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4. Select the Index Entity from the Properties tab.

5. In the Query section, select a function from the dropdown menu.

6. Click the button and select the Fields and Parameters from the dropdown menu

to add into the query function. Click the button to remove a Field or Parameter.

7. Customize the values and weights for Fields and Parameters.

You can organize queries into nested structures when the function represents a
logical group. You can create logical groups by using operators such as AND and OR.
An example for a logical group function is shown below:
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Note: You cannot add fields and parameters for logical functions.

Adding a Match Case
Complete the following steps to add a Match Case.

Procedure
1. From the Project Explorer, navigate to Configurations > CustomQueryConfig.cqc.

2. In the CustomeQueryConfig.cqc panel, expand the CustomQueryConfig and select a
Query Config where you want to add Match Cases.

3. In the Properties tab, click Match Case and then click Add Match Case to provide the
match case rule details.

4. For each Querylet, specify the Strength, Max Penalty, Max Reward, Threshold, and
Weight.

5. Select the Querylet type from Type dropdown menu.
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Custom Query Config Validations
There are several validations applied on Custom Query Config to ensure it's error-free and
accurate export. The following are the validations that are applied to the Custom Query
Config.

Validations on Custom Query Config:

l Query config name cannot be empty.

l Custom config query file should be given to custom query config.

l Each custom query confing file should have a unique file name.

l Each custom query confing should have a unique name.

l The custom query config file format must be .xml.

Validations on Querylet Config:

l Querylet name cannot be empty.

l Index entity cannot be empty for a querylet. There should be atleast one index entity
associated with a querylet.

l Invalid index entity should not be associated with a querylet.
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l Each custom querylet should have a unique name.

l The querylet type cannot be empty.

Validations on Match Case:

l Max reward value should be between 0.00 to 1.00.

l The strength value should be between 0.00 to 1.00.

l The max penalty value should be between 0.00 to 1.00.

l The decimal places in the max reward value should not be more than two.

l The decimal places in the strength value should not be more than two.

l The decimal places in the max penalty value should not be more than two.

l The threshold value for core querylet should be between -1.00 to 1.00.

l The threshold value for other querylets except the core querylet should be between
0.00 to 1.00.

l The decimal places in the threshold value should not be more than two.

l The weight value for core querylet should be between -1.00 to 1.00.

l The weight value for other querylets except the core querylet should be between 0.00
to 1.00.

l The decimal places in the weight value should not be more than two.

l At least one match case must be defined for query config.

Validations on Query:

l At least one query should be defined for a querylet.

l At least two sub queries must be defined for AND & OR function. You can define more
than two sub queries.

l The weight value for function definition should be between 0.00 to 1.00.

l The decimal places in the weight value for function definition should not be more
than two.

l Field definition name and parameter name must be unique.
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Exporting Custom Query Config
Complete the following steps to export a Custom Query Config Model.

Procedure
1. In the Project Explorer, right-click the Configurations folder and click Export. The

Export wizard is displayed.

2. Expand MDM Patterns Indexer Configuration, select MDM Custom Query
Configuration Format, and then click Next. The MDM Custom Query Configuration
Export Wizard is displayed.
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3. Select the CustomQueryConfig.cqc file checkbox.

4. The default export destination is Project (Location:/Exports/MDMExportFolder). If you
want to change the export folder, select Path and click Browse to select a different
destination export folder.

Note: You can export multiple Custom Query Config at the same time.

5. Click Finish to export the file.

The Custom Query Config is exported as a zip file in the Exports folder.

Import Custom Query Config Model
Complete the following steps to import a Custom Query Config Model.

Procedure
1. In the Project Explorer, right-click the Configurations folder and then click Import.

The Import Patterns Indexer Configuration wizard is displayed.
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2. Expand MDM Patterns Indexer Configuration, select Import MDM Custom Query
Configuration, and then click Next. The Custom Query Config Import wizard is
displayed.
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3. Click Browse to navigate to the From Directory where a valid
customQueryConfig.xml file is saved.

4. Select the customQueryConfig.xml file and click Next. The Indexer Config Selection
wizard is displayed.

Note: Do not select referenced Query Config files as the referenced files
are also saved in the same directory where the main
customqueryconfig.xml is saved.
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5. Select referenced indexer configuration file and click Next.

6. The Import Summary wizard is displyed. This wizard diaplays the import summary
and validation errors, if any. Click Finish.
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The Custom Query Config Model is imported in the current project.
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WSDL and Service Methods
The WSDL chapter covers the High level features and the implementation scope for
dynamic web services. It also describes the optional generation of dynamic web services
for high usability and deployment of new web services unlike static web services which are
bundled with TIBCO MDM.

Overview
The current web service interface is generic and data model agnostic, but suffers from poor
usability. The primary problem is generic representation of data services which makes it
difficult for the user to define a web services client for it. The schema is not rigorous and
has limited validation capabilities. Another problem is the use of 'special' keywords (not
schema exposed) which have to be understood before proper use. For example for record
services, the specific name 'PRODUCTID' has to be used in order to identify the primary
record identifier.

The primary goal for the dynamic services is to make the web services simple and easy to
use.

The dynamic services will especially be useful for record services based on an actual
Repository, including attributes and information, to allow a more meaningful and
syntactically tight schema. The number of such services can be different for each
repository, hot deployed and redeployed if any changes are required.

The user will define a specific data repository, with all the needed attributes and will
generate from this definition a repository specific web service in form of a WSDL definition
and an associated implementation. This web service has six fundamental methods for
record data management available (Add, Modify, Delete, Find, Validate, and Build
Relationship). This newly generated web service can then be deployed onto an TIBCO MDM
Server instance to be used.
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Warning: The ECMClasses.jar is bundled with TIBCO MDM Studio. However, if
TIBCO MDM server is upgraded and running on different or same machine,
perform the following steps:

Set the $MQ_HOME on the machine where TIBCO MDM Studio is running

Set the environment variable for the MQ_HOME

Set the environment variable for the MQ_LIB

Copy the latest ECMClasses.jar file into $MQ_HOME/lib/mq folder where TIBCO
MDM Studio is running (Only if TIBCO MDM Server is running on different
machine or the local server is having a lower version of TIBCO MDM Studio than
the compatible version).

Service Methods
The WSDL Generator Plug-in takes in a repository file and generates an output WSDL and
corresponding java source code. The code is then compiled to a deployable web services
entity (.aar) file.

The generation is offered through Wizard, which is provided as a 'New Project' wizard in
the repository designer. The WSDL generation wizard collects the following inputs from the
user:

l Repository Folder name containing the Repository Models

l Repository file ( *.rep)

l Repository (Repository on which you want to generate the WSDL)

l Project Name

l Selection of relationship with target repository

The WSDL should have the following properties:

l Use a single namespace for request and response

l Use the document literal flavor

l Use a SOAP fault for conditions

The schema should have the following properties:
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l Define XSD types for each attribute

l Use a close mapping of XML Schema base types to TIBCO MDM base types

l Account for further type restrictions such as length

l Support multi-value attributes

Repositories with FED attributes
The implementation for performing service method operations on repositories with a
Timestamp type attribute mapped to "EFFECTIVEDATE" is as follows:

l Add operation: You can add any record including future dated records to such
repository.

l Update/Delete operations: You can Update and Delete all records including future
effective dated records.
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l Find operation: You can search only those records which are confirmed and already
effective. The EFFECTIVEDATE attribute value should be less than current system date
for Find operation to be successful. Find operation now supports options searching
for FED versions only, include FED versions and exclude FED versions. The option for
search is set as value for context variable 'EffectiveDateSearchOption'. The available
values are, I for including FED versions, O for only FED versions, and E for excluding
FED versions. If none provided FED versions are excluded from the search.

Generating WSDL
Using the eclipse wizard, you can generate the WSDL.

Procedure
1. Go to File - > New - and click Other.

2. The Select a wizard screen is displayed.
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3. Select MDM WSDL Generator from the WSDL Generator tree node.

4. Click Next. The Wizard displays the WSDL Generator screen.

5. Click Browse and select the path where the input file exists. All the *.rep files are
populated.
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6. Select the appropriate *.rep file from the Select File drop-down list. Based on the
selected repository file, the repositories are displayed in the Select Repository drop-
down list.

7. Select a repository from the Select Repository drop-down list.

8. By default, the Relationship artifact is selected. You cannot deselect the relationship.
The wsdl includes all the relationships in the repository.

9. Click Next. The New Project screen is displayed

10. Enter the appropriate project name in the Project Name field. By default, the project
name is <repository name_webservice.

11. Click Next. The New Project screen is displayed.
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12. To select the depth of the level of Repository or Relationships, right - click the
relationship and point to Auto select to level and select the depth. For example, 3.
The depth of the level is configured in the preference page. To configure the
Preference perform the following.

l From the Window, click Preference.

l Enter the level in the Auto Select Level in WSDL Tree Selection Page field.
The value must be between 1to 9.
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l Click Apply.

l Click OK.

13. Alternatively you can also manually select the relationship which you want and click
Next. The Generation Options screen is displayed.
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14. Enter the appropriate package name in Package Name field. By default, a package
name is provided. The package name convention is
com.tibco.mdm.dynservices.<repository name>_webservice.You cannot modify the
package name.

15. Click Finish.

Warning: While generating WSDL for large repository models, TIBCO MDM
Studio hangs and WSDL project gets generated with an error. To fix this
issue, refer to the troubleshooting section WSDL Generation Failed due to
OutOfMemoryError.

WSDL and XML Schema Generation
During the WSDL generation process, four files are created.

l WSDL file

l Request XSD file

l Response XSD file

l Generic Type file

WSDL-Generation-Fail.htm
WSDL-Generation-Fail.htm
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WSDL file

The WSDL file contains the primary contract with the new service definition and the six
primary operations (add, update, delete, find, validate, and build Relationship). It uses the
interoperable document literal representation.

Request XSD file

The Request contains a type definition of the entire repository and for each attribute of the
repository. This type should have the type mappings as described in table XSD Types,
including the TIBCO MDM property length which should map for example to xsd:maxLength
for a string. The three write operations (add, modify, delete) will have an entire record as
input, only the read operation (find) will have a record id as input - and return the entire
record as response.

Note: The types definition are defined in the repository model. If you want to
change the type definition it must be changed at the repository model level.

Response XSD file

The Response file includes the request type definitions and therefore does not need to
create many dynamic types. Only for the Response itself, it will create a type for all four
operations. Furthermore, the ResultType and EventType is contained in there which is used
by the three write operations responses.

Generic Type file

The generic type file contains the UserInfo type.

XSD Types

Type Name Type Mapping Type Attributes

MDM BOOLEAN Xsd:boolean -

MDM Integer Xsd:integer -

MDM Decimal Xsd:decimal MDM length
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Type Name Type Mapping Type Attributes

xsd:fractionDigits

MDM String Xsd:string MDM length,
xsd:maxInclusive

MDM File Xsd:string Xsd:maxLength = 255

MDM Amount Xsd:decimal MDM length

xsd:fractionDigits

MDM Custom Decimal Xsd:decimal MDM Length,
Xsd:fractionDigits

MDM Date Xsd:dateTime

Service Methods
You can perform the following service methods for any repository.

l Add Method - This method adds a new record along with the relationship records
into the TIBCO MDM repository. This supports the following:

o Adding new Parent Record

o Adding new child Records

l Modify Method - This method modifies the existing record along with the
relationship records in the TIBCO MDM repository. This supports the following:

o Modifying the Parent Record

o Adding new child record

o Modifying existing child record

o Deleting existing child record

l Delete Method - This method deletes the record along with the relationship records
from the TIBCO MDM repository. This supports the following:
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o Deleting the Parent record

o Deleting the Parent along with all Child relationships

l Find Method - This method finds the record along with the relationship records in
the TIBCO MDM repository. This supports the following:

o Find All Parent records

o Find the existing record bundle for the specified Product Id and Product ID Ext

o Find all the relationship records for the specified parent Product ID and
Product ID Ext and relationship name

o Find a specific relationship record for specified parent and child product ID and
Product ID Ext

l Validate Method - This method validates the record along with the relationship
records in the TIBCO MDM repository. This method supports the following:

o Validate the Record Bundle for Structural and Rule base errors

l Build Relationship Method - This method adds the relationship objects into the
cache and it is the supporting method for add, modify and delete. The Build
relationship is not recommended from Soap Client such as SOAP UI as this
functionality is to improve performance in UI Builder. The Build Relationship is used
for adding child relationship objects from a session into the cache. Whenever any
addition or modifications (add/update/delete) are done to the parent record then the
build relationship is attached to the parent object from cache to form the record
bundle. The entire record bundle is saved to TIBCO MDM.

l Copy Method - The copy operation is currently supported only through SOAP
requests using generated web services. We support only deep cloning of records.
Upon successful operations the first version of the cloned record will be created and
is available for view.

The following Sample depicts the service methods for the PersonAddressClient (PAC)
repository model.

JSON Format
{'Envelope':{'Body':{'<servicemethodName>Request':{'UserInfo':{'UserName':'<mdm user
id>','Password':'<mdmpassword>','Enterprise':'<mdm enterprise>'},
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'Context':
{'Validation':'false','Process':'true','SystemAttributeReturn':'false','ReturnFileAsAttachment':'
false','EffectiveDateSearchOption':'E','DeleteAllRelatedRecords':'false','PerspectiveName':'','
StartCount':'1','RecordCount':20},'<RepositoryName>':{< list of repository attributes comma
separated in name: value format>}}}}}

In the envelope, the <serviceMethodName> is replaced by add, update or delete followed
by the repository name.

For example, addPerson/updatePerson/deletePerson.

<RepositoryName> is replaced by the repository name. For example, Person

<mdmUserid><mdmpassword><mdmEnterprise> are required for the first time.UserInfo
input. It is not required for each request as these details are stored in the session from
previous requests.

In the context, options are provided to apply on the record bundle.

Validation= Validates the record bundle. The return value is true or false.

Process=true/false

SystemAttributeReturn= Returns the System Attributes along with repository attributes.
The return value is true or false.

ReturnFileAsAttachment= returns the file as attachment. The return value is true or false.

EffectiveDateSearchOption= Specify the value ’E’ if it is effective date search option.

DeleteAllRelatedRecords= It is used in the delete functionality for deleting all child
records. The return value is true or false

PerspectiveName= Specify the perspective name

StartCount= Supports the pagination

RecordCount= Supports the pagination

Add Method

Request:
URL:
/eml/json/wizard/PersonService/addPerson
Content-Type:
Application/x-www-form-urlencoded
HTTP Method:
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POST
Parameter Name:
JsonInput
{

"Envelope" : {
"Body" : {

"AddPersonRequest" : {
"Context" : {

"Validation" : "false",
"Process" : "true",
"SystemAttributeReturn" : "false",
"ReturnFileAsAttachment" : "false",
"EffectiveDateSearchOption" : "E",
"DeleteAllRelatedRecords" : "false",
"PerspectiveName" : ""

},
"Person" : {

"ID" : "99999",
"IDEXT" : "extension-1",
"FIRSTNAME" : "xxxxx",
"LASTNAME" : "xxxxx"

}
}

}
}

}

Successful Response:

{
'Envelope' : {

'Body' : {
'AddPersonResponse' : {
'Result' : {

'@code' : 'SVC-11025',
'@severity' : 'Info',
'Message' :
'Service VALIDATE_PROCESS executed successfully',
'Event' : {

'EventId' : '61001'
}

}
}

}
}

}
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Failure Response:

{
'Envelope' : {

'Body' : {
'Fault' : {
'faultcode' : '111',
'faultstring' : 'Cannot save record; record already exists',
'detail' : {

'FaultDetails' : {
'CimErrorList' : {
'ErrorCode' : '61001',
'ErrorMessage' : 'Cannot save record; record already

exists.'
}

}
}

}
}

}
}

Modify/Update

Request:
URL:
/eml/json/wizard/PersonService/updatePerson
Content-Type:
Application/x-www-form-urlencoded
HTTP Method:
POST
Parameter Name:
JsonInput
{

'Envelope' : {
'Body' : {

'updatePersonRequest' : {
'Context' : {

'Validation' : 'false',
'Process' : 'true',
'SystemAttributeReturn' : 'false',
'ReturnFileAsAttachment' : 'false',
'EffectiveDateSearchOption' : 'E',
'DeleteAllRelatedRecords' : 'false',
'PerspectiveName' : ''

},
'Person' : {
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'ID' : '99999',
'IDEXT' : 'extension-1',
'FIRSTNAME' : 'xxxxx',
'LASTNAME' : 'xxxxx'

}
}

}
}

}

Success Response:

{
"UpdatePersonResponse" : {

"Result" : {
"@code" : "SVC-11025",
"@severity" : "Info",
"Message" : "Service NOVALIDATE_PROCESS executed successfully.",
"Event" : {
"EventId" : 63025

}
}

}
}

Failure Response:

{
'Envelope' : {

'Body' : {
'Fault' : {
'faultcode' : '111',
'faultstring' : 'SVC - 11038 : Data unchanged, request ignored',
'detail' : {

'FaultDetails' : {
'CimErrorList' : {
'ErrorCode' : 'SVC - 11038 ',
'ErrorMessage' : ' SVC - 11038 : Data unchanged, request

ignored.'
}

}
}

}
}



TIBCO® MDM Studio Repository Designer User Guide

269 | WSDL and Service Methods

}
}

Delete

l Identified by ID and/or IDExt

l Exception: Record not found

Request:
URL:
/eml/json/wizard/PersonService/deletePerson
Content-Type:
Application/x-www-form-urlencoded
HTTP Method:
POST
Parameter Name:
JsonInput
{

'Envelope' : {
'Body' : {

'DeletePersonRequest' : {
'Context' : {

'Validation' : 'false',
'Process' : 'true',
'SystemAttributeReturn' : 'false',
'ReturnFileAsAttachment' : 'false',
'EffectiveDateSearchOption' : 'E',
'DeleteAllRelatedRecords' : 'false',
'PerspectiveName' : ''

},
'Person' : {

'ID' : '99999',
'IDEXT' : 'extension-1'

}
}

}
}

}

Successful Response:

{
'Envelope' : {

'Body' : {
'DeletePersonResponse' : {
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'Result' : {
'@code' : 'SVC - 11032',
'@severity' : 'Info',
'Message' : 'SVC - 11032 : REASON - Record(s)deleted

successfully ',
'Event' : {

'EventId' : 61001
}

}
}

}
}

}

Failure Response:

{
'Envelope' : {

'Body' : {
'Fault' : {
'faultcode' : 'CAT-1141',
'faultstring' : 'CAT - 1141 : Record with Record ID = 12345,

Record ID Extension = not found ',
'detail' : {

'FaultDetails' : {
'CimErrorList' : {
'ErrorCode' : 'CAT-1141',
'ErrorMessage' : 'CAT-1141: Record with Record ID=12345,

Record ID Extension= not found'
}

}
}

}
}

}
}

Find/Retrieve

l Getting a record Bundle for specific Person ID and person IDExt

l Getting all the Persons

l Getting All Addresses of a Person with id '99999' and IDExt as 'extension-1'

Request:
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URL:
/eml/json/wizard/PersonService/findPerson
Content-Type:
Application/x-www-form-urlencoded
HTTP Method:
POST
Parameter Name:
JsonInput
(Getting a record Bundle for specific person id and person id ext)
{

'Envelope' : {
'Body' : {

'FindPersonRequest' : {
' Context' : {

'Validation' : 'false',
'Process' : 'true',
'SystemAttributeReturn' : 'false',
'ReturnFileAsAttachment' : 'false',
'EffectiveDateSearchOption' : 'E',
'DeleteAllRelatedRecords' : 'false',
'PerspectiveName' : '',
'StartCount' : '1',
'RecordCount' : 20

},
'FindPersonID' : [{

'ID' : '99999',
'IDEXT' : 'extension-1'

}
]

}
}

}
}
Getting all the Persons
{

'Envelope' : {
'Body' : {

'FindPersonRequest' : {
' Context' : {

'Validation' : 'false',
'Process' : 'true',
'SystemAttributeReturn' : 'false',
'ReturnFileAsAttachment' : 'false',
'EffectiveDateSearchOption' : 'E',
'DeleteAllRelatedRecords' : 'false',
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'PerspectiveName' : '',
'StartCount' : '1',
'RecordCount' : 20

},
'FindAllPersons' : 'true'

}
}

}
}
Getting All Addresses of a Person with id '99999' and id ext as
'extension-1'
{

'Envelope' : {
'Body' : {

'FindPersonRequest' : {
' Context' : {

'Validation' : 'false',
'Process' : 'true',
'SystemAttributeReturn' : 'false',
'ReturnFileAsAttachment' : 'false',
'EffectiveDateSearchOption' : 'E',
'DeleteAllRelatedRecords' : 'false',
'PerspectiveName' : '',
'StartCount' : '1',
'RecordCount' : 20

},
'FindPersonID' : [{

'ID' : '99999',
'IDEXT' : 'extension-1',
'Relationships' : {

'PersonToAddress' : {
'findAll' : 'true'

}
}

}
]

}
}

}
}
Response:
{

"Envelope" : {
"Body" : {

"FindPersonResponse" : {
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"PersonList" : {
"Person" : {

"ID" : "99999",
"IDEXT" : "extension-1",
"FIRSTNAME" : "xxxxx",
"LASTNAME" : "xxxxx",
"PersonToClientList" : {

"PersonToClient" : [{
"ParentInfo" : {

"ParentCatalogName" : "Person",
"ParentRecordID" : "99999",
"ParentRecordIDEXT" : "extension-1"

},
"HOURLYRATE" : "100",
"CLIENT" : {

"ID" : "10000",
"IDEXT" : "p",
"CONTAINS" : "no",
"NAME" : "",
"DEPARTMENTNAME" : "San Fran",
"BUSINESSTYPE" : "Retail",
"PROJECTNAME" : "MDM",
"DURATION" : "6"

}
} {
"ParentInfo" : {

"ParentCatalogName" : "Person",
"ParentRecordID" : "99999",
"ParentRecordIDEXT" : "extension-1"

},
"HOURLYRATE" : "100",
"CLIENT" : {

"ID" : "10001",
"IDEXT" : "p",
"CONTAINS" : "no",
"NAME" : "",
"DEPARTMENTNAME" : "San Fran1",
"BUSINESSTYPE" : "Retail1",
"PROJECTNAME" : "MDM1",
"DURATION" : "6"

}
}

]
}
"PersonToAddressList" : {
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"PersonToAddress" : [{
"ParentInfo" : {

"ParentCatalogName" : "Person",
"ParentRecordID" : "99999",
"ParentRecordIDEXT" : "extension-1"

},
"Type" : "home",
"ADDRESS" : {

"ID" : "12000",
"IDEXT" : "p",
"ADDRLINE1" : "11111 san fran"

}
} {
"ParentInfo" : {

"ParentCatalogName" : "Person",
"ParentRecordID" : "99999",
"ParentRecordIDEXT" : "extension-1"

},
"Type" : "office",
"ADDRESS" : {

"ID" : "12001",
"IDEXT" : "p",
"ADDRLINE1" : "2222 san fran"

}
}

]
}

}
}

}
}

}
}

Validate Method

Request:
URL:
/eml/json/wizard/PersonService/validatePerson
HTTP Method:
POST
Parameter Name:
JsonInput
{

"Envelope" : {
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"Body" : {
"ValidatePersonRequest" : {
"Action" : "add",
"IncludeFailedRecordsInResponse" : "true",
"Person" : {

"ID" : 1,
"IDEXT" : "p",
"FIRSTNAME" : "Jon",
"LASTNAME" : "S",
"RELIGIOUS" : "Jay",
"GENDER" : "Male",
"HEIGHT" : 5.5,
"WEIGHT" : 130,
"EYECOLOR" : "Black",
"EMAIL" : "jon@gmail.com",
"LINKEDINID" : "joh"

}
}

}
}

}
Validation failure response:
{

"ValidatePersonResponse" : {
"ValidationResult" : {

"ErrorList" : {
"Error" : [{

"ErrorMessage" : "'Weight' has failed validation. The
value ('130') was not present in the valid value list.",

"RelationshipName" : "PERSON",
"ID" : 1,
"IDEXT" : "p",
"AttributeName" : "WEIGHT"

}, {
"ErrorMessage" : "Attribute 'First Name' is transformed

from ('Jon') to ('1-NEWVAL')",
"RelationshipName" : "PERSON",
"ID" : 1,
"IDEXT" : "p",
"AttributeName" : "FIRSTNAME"

}, {
"ErrorMessage" : "Cannot save record; record already

exists. If you cannot find a confirmed version of this record, it
may currently be in add or delete approval process.",

"RelationshipName" : "PERSON",
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"ID" : 1,
"IDEXT" : "p",
"AttributeName" : "PRODUCTID"

}
]

},
"Person" : {
"ID" : 1,
"IDEXT" : "p",
"FIRSTNAME" : "Jon",
"LASTNAME" : "S",
"RELIGIOUS" : "Jay",
"GENDER" : "Male",
"HEIGHT" : 5.5,
"WEIGHT" : 130,
"EYECOLOR" : "Black",
"EMAIL" : "jon@gmail.com",
"LINKEDINID" : "jon"

}
}

}
}
Validation success response:
{

"ValidatePersonResponse" : {
"ValidationResult" : {

"Info" : "Record Bundle validation is successful"
}

}
}

Build Relationship

l This creates a new relationship record of PersonToClient for person id 200 and
extension tibco. The mode can be Add/Edit/Delete.

Request:
URL:
/eml/json/wizard/PersonService/buildRelationship
HTTP Method:
POST
Parameter Name:
JsonInput
{

'Envelope' : {
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'Body' : {
'RelationshipRequest' : {
'Mode' : 'Add',
'PersonToClient' : {

'ParentInfo' : {
'ParentCatalogName' : 'Person',
'ParentRecordID' : '200',
'ParentRecordIDEXT' : 'tibco'

},
'HOURLYRATE' : '100',
'CLIENT' : {

'ID' : '10000',
'IDEXT' : 'p',
'CONTAINS' : 'no',
'NAME' : '',
'DEPARTMENTNAME' : 'San Fran',
'BUSINESSTYPE' : 'Retail',
'PROJECTNAME' : 'MDM',
'DURATION' : '6'

}
}

}
}

}
}
Successful Response
{

'Envelope' : {
'Body' : {

'RelationshipResponse' : {
'Result' : {

'Message' : 'Success',
'Event' : {

'EventId' : 'xxx'
}

}
}

}
}

}
Failure Response:
{

'Envelope' : {
'Body' : {

'Fault' : {
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'faultcode' : ' xxx',
'faultstring' : 'xxxx' : 'Unable to add relationship into

cache',
'detail' : {

'FaultDetails' : {
'CimErrorList' : {

'ErrorCode' : 'CAT-1141',
'ErrorMessage' : 'Unable to add relationship into

cache .'
}

}
}

}
}

}
}

Copy Method

l For Copy operation JSON sample can not be provided as it is not supported by MDM
UI builder . However, an XML sample is as follows:

Request

<soapenv:Envelope
xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
xmlns:ns="http://tibco.com/mdm/dynservices/parent_webservice1/wsdl/2.0">

<soapenv:Header/>
<soapenv:Body>

<ns:CopyParentRequest>
<!--Optional:-->
<ns:UserInfo>

<ns:UserName>a</ns:UserName>
<ns:Password>a</ns:Password>
<ns:Enterprise>party</ns:Enterprise>

</ns:UserInfo>
<!--Optional:-->
<ns:Context>

<!--You may enter the following 15 items in any order-->
<!--Optional:-->
<ns:Validation>true</ns:Validation>
<!--Optional:-->
<ns:Process>true</ns:Process>

</ns:Context>
<ns:Parent>

<!--You may enter the following 13 items in any order-->
<!--Optional:-->
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<ns:RecordIdentity>
<ns:ID operator="eq">A3</ns:ID>
<!--Optional:-->
<ns:IDEXT operator="eq">333</ns:IDEXT>

</ns:RecordIdentity>
<!--Optional:-->
<ns:ID>A3A</ns:ID>
<!--Optional:-->
<ns:IDEXT>33A</ns:IDEXT>
<!--Optional:-->
<ns:PtoCAList>

<!--1 or more repetitions:-->
<ns:PtoCA>

<!--You may enter the following 3 items in any order--
>

<ns:ParentInfo>
<!--You may enter the following 4 items in any

order-->
<ns:ParentCatalogName>PARENT</ns:ParentCatalogName>
<ns:ParentRecordID>A3</ns:ParentRecordID>
<!--Optional:-->
<ns:ParentRecordIDEXT>333</ns:ParentRecordIDEXT>

</ns:ParentInfo>
<!--Optional:-->
<ns:RecordIdentity>

<ns:ID operator="eq">B3</ns:ID>
<!--Optional:-->
<ns:IDEXT operator="eq">333</ns:IDEXT>

</ns:RecordIdentity>
<ns:CHILDA>

<!--You may enter the following 7 items in any
order-->

<!--Optional:-->
<ns:ID>B3A</ns:ID>
<!--Optional:-->
<ns:IDEXT>33A</ns:IDEXT>

</ns:CHILDA>
</ns:PtoCA>

</ns:PtoCAList>
</ns:Parent>

</ns:CopyParentRequest>
</soapenv:Body>

</soapenv:Envelope>

Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/">
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<soapenv:Body>

<ns2:CopyParentResponse xmlns:ns2="http://tibco.com/mdm/dynservices/parent_
webservice1/wsdl/2.0">

<ns2:Result code="SVC-11025" severity="Info">

<ns2:Message>Service ''VALIDATE_PROCESS'' executed successfully.</ns2:Message>

<ns2:Event>

<ns2:EventId>76045</ns2:EventId>

</ns2:Event>

<ns2:ErrorList/>

<ns2:ValidationResult>

<ns2:RecrodDeatils>

<ns2:CatalogName>PARENT</ns2:CatalogName>

<ns2:ID>A3A</ns2:ID>

<ns2:IDEXT>33A</ns2:IDEXT>

<ns2:PIDKEY>-1</ns2:PIDKEY>

</ns2:RecrodDeatils>

<ns2:ErrorList/>

<ns2:RelationShipsList/>

</ns2:ValidationResult>

</ns2:Result>

</ns2:CopyParentResponse>

</soapenv:Body>

</soapenv:Envelope>
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Note:
The specified format for Date type attribute is "yyyy-mm-dd". If the format is not
in the specified format then "invalid date format (<date in request xml>) with
out - s at correct place" error occurs.

The ’RecordIdentity’ tag is supported mainly in update and copy operations. This
tag is used in update operation to provide the identity of the record to be found
in the system so that it could be mutated. The ID and IDEXT tags are used to
provide the new value.

In copy operation record identity tag is used to find the record and the related
record to be cloned. The ID, IDEXT tags are used to provide the identity of the
cloned version.

Deployment of Services
The outcome of the generation process is a deployable entity <service name>.aar. The .aar
file can be deployed into the TIBCO MDM Server.

For more information on how to deploy WSDL see Deployment

On the TIBCO MDM server, a directory named dynservices/services has been created under
MQ_HOME. The <Repository Name>Service.aar file is deployed into the MQ_
HOME/dynservices/services directory.

Note: When the TIBCO MDM server is running on a remote machine you must
refer to a local copy of %MQ_HOME%.
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Validation
This chapter explains validation that is performed on your repository model.

Repository Model Validation
The Repository Designer performs validation at several levels to ensure that your repository
details and relationships are compliant with the TIBCO MDM format.

Display of validation errors
All validation errors are displayed in the Problems tab below the drawing pane.

Warnings are also displayed here but you can ignore these, since they are Business Studio
specific. You only need address errors prefixed with Repository Modeler.

The errors are categorized based on:

l Description - A description of the validation error.

l Resource - The name of the Resource model that has a validation error.

l Path - The path to the model being validated.

l Type - The type of error.

Types of Validation
The following validations are performed:
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Repository Level Validation

ID and IDEXT Attributes

Repositories must have a single ID and IDEXT attribute. These are created by default when
you add a new repository to your design, and they should not be deleted. If you attempt to
add more than one ID or IDEXT attribute per repository, you will get a validation error.

Valid Repository Name

All Repositories should be named, and the name cannot contain spaces. Repository Name
can not contain invalid characters. It allows only alphanumeric character, _*.-@<>/\
characters, characters from other languages and case insensitive.

Unique Repository Name

Repository names should be unique within a repository model (.rep file).

Valid Table Name

Table name cannot contain spaces. Table Name cannot contain invalid characters. It allows
only alphanumeric character and $#_ characters.

Attribute Level Validation

Valid and Unique Attribute Names

Attribute names cannot be blank, contain any spaces, or use any reserved names. Each
attribute in a repository must have a unique name.

If you provide the same name to two attributes, you will get a validation error. Attribute
Name can not contain invalid characters.

It allows only alphanumeric character and _ characters and are case insensitive. It should
contain less than 30 characters.
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Attribute Reserved Names

Some of reserved names are "STATE","MODVERSION","MODDATE", "MODMEMBERID",
"CATALOGVERSIONNUMBER","CHECKSUM","PRODUCTKEYID",
"LASTIMPORTTIME","ACTIVE","ENDEFFECTIVEDATE","CATALOGID",
"BATCHID","PROCESSLOGID","CREATIONDATE","LASTCONFIRMEDVERSION",
"OWNERID","OWNERTYPE","PARENTVERSION"

Attribute Positions

If there is one attribute where the attribute property position is set to a valid non-null
value then all of the attribute must have the attribute property set to a valid value.

Attribute Column Positions

The column position for an attribute cannot be negative or zero. Define a positive number
as column position.

Attribute Column Name

Column name for attribute should contain less than 28 characters.

Column name for Multi- Value attributes should be less than 26 characters.

Column Name for attributes can not contain invalid characters and white space. It allows
only alphanumeric character and $#_ characters.

String Attribute Length

Length for attributes of type string cannot be negative (smaller than zero) or more than
4000 characters.

Attribute Group Name

Attribute Group Names cannot contain spaces. Attribute group name should contain less
than or equal to 30 characters.

Effective Date Attribute

There cannot be more than one attribute as Effective date. The Effective date must of
“TIMESTAMP” type.
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Input Map

Input Map name in repository cannot be Undefined.

Input Map should have at least one common column in Input Map for joining Data Source.

Input Map cannot contain spaces.

Input Map name and description cannot contain more than 80 characters.

Input Map descriptions cannot be blank.

Relationship Validation

Reverse Relationship Name

You must provide a reverse relationship name and description.

No spaces in Relationship and Reverse Relationship Name

The relationship name and the reverse relationship name cannot contain any spaces.

Unique Relationship and Reverse Relationship Names

The relationship name cannot be the same as the reverse relationship name.

Unique Duplicate Relationship and Reverse Relationship Names

The duplicate relationship name cannot be the same as the duplicate reverse relationship
name.

Relationship Attribute and Relationship Attribute Group
Validation

Relationship Attribute Group

A Relationship Attribute Group must contain a relationship attribute, it cannot be empty.
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Relationship Attribute Group connection to relationship

A Relationship Attribute Group once created must be connected to a relationship using a
connector.

Single connector between Relationship and Relationship Attribute Group

Only a single connector should be used between a Relationship Attribute Group and a
relationship.

Datasource Validation

Valid and Unique Datasource Names

Datasource name cannot be blank, contain any spaces.

Each Datasource name must have a unique name.

Length of Datasource name cannot be more than 80 characters.

If you provide the same name to two Datasource, an validation error occurs.

It allows only alphanumeric character and _ characters.

New Datasource will be created.

Datasource name already exists and will be modified.

Valid Datasource Description

Datasource description cannot be empty.

Valid Datasource Delimiter character

Datasource delimiter character cannot be empty.

Valid and Unique Datasource Attribute Names

Datasource Attribute name cannot be blank, contain any spaces.

Each datasource Attributes name must have a unique name.
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Attribute name for datasource should contain less than 28 characters.

If you provide the same name, an validation error occurs.

It allows only alphanumeric character and _ characters and are case insensitive.

Valid Datasource Attribute Description

Datasource description cannot be empty.

Datasource Attribute Position

Datasource Attribute Position maximum value cannot be more than 999 minimum value
cannot be a negative or zero.

Datasource Attributes Limit

The maximum number of attributes in a Data Source is 999.

Datasource Attribute Length

Datasource attribute length cannot be a invalid Length.

The length specified for Data Source Attribute in Data Source must be a number.

The Length for attribute of type 'DECIMAL' must be in between '7' and '32' or set to 0.

The Length for attribute of type 'CUSTOM_DECIMAL' must be in between '1' and '29'.

The datasource attribute length cannot be negative.

The Length for attribute of type 'STRING' must be in between '0' and '4000'.

The Length for attribute of type 'BOOLEAN' must be '5'.

Output Map Validation

Valid Output Map Name

Valid and Unique Output Map Names.

Output map names cannot be blank, contain any spaces.
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Each output map name in a repository must have a unique name.

Length of output map name cannot be more than 80 characters.

If you provide the same name to two output maps, an validation error occurs.

Valid Output Map Description

Output map description cannot be blank. Length of output map description cannot be
more than 80 characters.

Valid Output Map Repository

Repository field cannot be empty. You must select repository.

New Output Map will be added to the repository.

Output Map already exists in repository and will be modified.

Valid Output Map sync Format

Sync Format field cannot be empty. You must select Sync Format.

Synchronization Format Validation

Valid Sync Format Name

Sync Format name cannot be blank, contain any spaces.

Each Sync Format name must have a unique name.

Length of Sync Format name cannot be more than 80 characters.

If you provide the same name to two Sync Format, an validation error occurs.

New Synchronization Format will be created.

Synchronization Format already exits and will be modified.

Catalog Type with name already exists. Provide different name.

Synchronization Format table with name already exists.
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Synchronization Format cannot be modified as Synchronization has already been
performed.

Valid Sync Format Description

Sync Format description cannot be blank.

Length of Sync Format description cannot be more than 80 characters.

Valid Sync Format Delimiter

Backslash character (\) constant is not allowed as Delimiter.

Delimiter cannot be empty.

Category Specific Attributes Validation

Category Code

The Category Code for a category name cannot be undefined.

The Category Name should have a category code.

The Category Code must be unique. The Category Code must not exceed 245 characters.

Category Name

The Category Name under parent category cannot be Undefined.

The Category Name must be entered and it cannot contain spaces.

The Category Name cannot have invalid character, it supports only alphanumeric and
should not exceed 245 characters.

The Category Name must be unique and is case insensitive.

Classification Scheme Name

The Classification Scheme Name cannot be Undefined.

You must provide a classification scheme name.
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The length of classification scheme name must not exceed 78 characters.

The Duplicate Classification name is not allowed for particular repository.

The Classification Name cannot have white spaces.

The Classification Scheme description cannot be blank.
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Database Schema Objects Import
You can design a repository model by importing a database schema objects (table or
Foreign Key constraints) in the TIBCO MDM Studio.

Creating a New Database Connection profile
A connection profile contains the connection property information needed to connect to a
database runtime instance.

Warning: Ensure that the database server is running before attempting to test
the connection or to connect to the database server.

Procedure
1. In Data Source Explorer, Right-click on Database Connections and select New.

2. The new connection profile dialog box is displayed.



TIBCO® MDM Studio Repository Designer User Guide

292 | Database Schema Objects Import

3. Select the database from the filter type list for which you want to create a
connection profile. For example, to list all databases that begin with the letter D,
enter a d in the text box. You can also enter a text string such as JDBC or embedded
to filter the list

4. Change the Name from the system-provided default, and enter a Description. You
must change the name if a connection profile already exists with the same name.

5. Click Next.

6. The driver details dialog box for the selected database if displayed.
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7. Select the appropriate driver from the drop-down list. If a driver definition does not
exist for the database type selected, you can create one. Click to create a new
driver definition. Select to edit an existing driver definition. .

8. The Properties tab displays the default template information for the selected driver.
Add or modify the Properties information in the General or Optional Properties tabs.

l Select the Save Password checkbox to save the password for the database
server login.

l Select Connect When the Wizard Completes checkbox to connect to the
database server once you finish defining this connection profile.

l Select Connect Every Time the Workbench Is Started checkbox to
automatically connect to the database server using this connection profile when
you launch Eclipse.

l Click Test Connection to ping the server and to verify that the connection
profile is working.

9. If you want to create database select the Create database checkbox and if you want
to upgrade your database then select the Upgrade database to current version
checkbox.
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10. Click Next to view Summary information.

11. Click Finish to create the connection profile.

Importing Model from Database Objects
You can design a repository model by importing a database schema objects (table or
Foreign Key constraints) in the TIBCO MDM Studio.

Note: To use Database Schema Import, you must have a database connection.
For more information on creating a new database connection refer to Creating a
New Database Connection profile.

For each selected table/view, repository would be generated and table column definitions
are mapped as repository attribute. Foreign key constraints are mapped as relationship
between the repositories. For example, the Table/View name is mapped to Repository
Name and the Column Name is mapped to Attribute Name.

Schema Object MDM Mapping

Table/View Repository Name

Column Attribute

Column Name Attribute Name

Column Type Attribute Type. For more
information, refer to MDM data type
Mapping

Column Length Attribute Length

Foreign key constraint Relationship

The Foreign key becomes the relationship between repositories (Selected table is source
repository and R_TABLE is target repository). For repository attribute, Oracle and SQL
server data types are mapped as:
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MDM Data Type Oracle data type SQL Server data type

String VARCHAR2 nvarchar, varchar, sysname

Decimal NUMBER numeric

Integer INTEGER Int, tinyint, smallint, bigint

Date DATE datetime2

Timestamp TIMESTAMP, TIMESTAMP(6) datetime

File BLOB, CLOB varbinary

Boolean BIT bit

MDM data type Mapping

Importing a Schema Objects
You can import the schema objects from the database connection you have in Data Source
explorer.

Procedure
1. In the Project Explorer, Right click on the Repository Models folder to which you want

to import and select Import.



TIBCO® MDM Studio Repository Designer User Guide

296 | Database Schema Objects Import

2. The Import Wizard is displayed.
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3. Expand MDM Repository Designer folder, select Import Model From Database and
click Next.

4. The New Database Repository Model page is displayed.
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5. By default, the model name is displayed as RepositoryModel.rep in File name field.
You can specify a different model name (*.rep) or choose the default name and click
Next.

6. The Database Table Selection page is displayed. Select the profile name from the
Profile drop-down list from which you want to select the schema.

7. Select the schema or catalog from the Schema/Catalog drop-down. For the selected
schema, all the Tables and Views are populated on the left hand side of the

table. There are checkboxes corresponding to the table or view.
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8. Select the checkboxes corresponding to the table or view which you want to include
in the repository model and then, right hand side of the table displays the selected
table or view. You can use the type filter text to search for the Table/View. If you
want to import Foreign key constraints as relationship for a particular table or view
then expand the table or view and select the checkbox corresponding to that
constraint.
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9. If you have selected a foreign key of a table and the target table (which is mandatory
to make a relationship) is not selected then an error is thrown prompting to select
the target Table.
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10. Select the target table or view.
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11. Click Next. The Attribute Selection Page is displayed.
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12. The repository attribute list with the default Name, Type, and Length values is
displayed. You can update values from all available columns for an attribute and you
can also use Association map to choose any attribute as ID (Record Id), IDEXT (Record
ID Extension), or EFFECTIVEDATE.

13. To delete any attribute, select the attribute and click . To delete more than one
attribute, hold the CTRL button select the attributes and click .

14. Similarly you can modify the relationship properties by selecting foreign key node.
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15. Click Finish. The Repository Model is created and displayed in the canvas.



TIBCO® MDM Studio Repository Designer User Guide

305 | Repository Model in Excel Format

Repository Model in Excel Format
Repository Model can be designed by importing an Excel sheet with predefined format for a
repository, attributes, relationships, and relationship attributes. The excel format
describing the format is explained in this chapter.

Note: You can find the sample excel file MDM Excel File Format.zip in the
TIBCO MDM Studio <version> Samples folder.

Repository Excel File Format
To import excel file into the repository model, you need to follow specified file formats and
editing rules.

The sequence of the sections must be 'Repository', 'Attributes', 'Relationship' and
'RelationshipAttributes'. Each section must be terminated by specifying "END" in first
column. The order of the predefined columns must also be same according to each
section.

Repository Section

l This section starts with the text 'Repository' in first column.
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l The Name field is mandatory whereas the Display Name, Description and the Table
Name are optional fields.

l Columns A-D must be used to specify repository fields.

l End the section with the text 'END' in the first column

Attribute Section

l This section starts with 'Attributes' in the first column.

l The Attribute Group and Name fields are mandatory, if left blank error occurs.

l Columns A-S must be used to specify attribute fields.

l The Display Name, Description, Column Name, Help, AssociationMap, MultiValued
table names are optional fields.

l The valid values for the Searchable, Multivalued, Use Common Table, Display in
Record List, Quick Viewable, Category Attribute, and Partition key are either 'Y' or 'N'.

l The Data Type field is mandatory and must contain valid MDM data types.

l The Length field is optional, however, it is recommended to specify length for each
attribute. The length must be provided as a numeric value.

l The Position field is optional. If specified, all the attributes in the repository must
have their position specified. The position must be provided as a numeric value.

l End the section with the text 'END' in the first column.

l The Include column indicates whether the row should be skipped or not. Specify 'Y'
if you do not want to skip this row or specify 'N' to skip the row.

Relationship Section

l This section starts with 'Relationships' in the first column.

l Columns A-F must be used to specify relationship fields.

l The Name, Description, Reverse Name and Reverse Description fields are optional.
If fields are not provided then it assigns default names and descriptions with respect
to target repository name. For example, if the Target Repository Name is Contact
then the default relationship names are, Name - ContactFwd and Reverse Name -
ContactBwd.

l The Target Repository Name field is mandatory and must contain valid Repository
Name.
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l End section with the text 'END' in the first column.

l The Include column indicates whether the row should be skipped or not. Specify 'Y'
if you do not want to skip this row or specify 'N' to skip the row.

Relationship Attribute Section

l This section starts with 'RelationshipAttributes' in the first column.

l Columns A-M must be used to specify relationship attribute fields.

l The Relationship Name field is mandatory and must be equal to the Relationship
Name.

l The Name field is mandatory and must contain a unique Relationship Attribute
Name.

l The Display Name, Description, Column Name, Help, AssociationMap properties
are optional.

l The valid values for the Searchable and Display in Record List fields are either 'Y' or
'N'.

l The Data Type field is mandatory and must contain valid MDM data type.

l The Length field is optional, however, it is recommended to specify length for each
attribute. The length must be provided as a numeric value.

l The Position field is optional. If specified, all the attributes in the repository must
have their position specified. The position must be provided as a numeric value.

l End section with the text 'END' in the first column.

l The Include column indicates whether the row should be skipped or not. Specify 'Y'
if you do not want to skip this row or specify 'N' to skip the row.

Designing Repository Model by Importing Excel
File
You can design a Repository Model by importing the excel file. The supported file formats
are .xlsx and .xls.

Procedure
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1. Right click on the Repository Models and click Import.

2. The Import wizard is displayed.

Expand the Excel2RepoModel folder, select Excel2RepoModel and click Next.

3. The New Excel2RepoModel wizard is displayed.
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By default, the RepositoryModel.rep filename is displayed, you can modify the
filename. Ensure that the filename extension is .rep. Click Next.

4. The New Excel2RepoModel wizard displays the excel file selection
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Click Browse and navigate to the path where the excel file is located. Select the
sheet where the information is saved from the Select Worksheet drop-down list.
Click Next

5. The New Excel2RepoModel wizard displays validations results.
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If there are any validation errors, the description of the errors is displayed. Click
Finish.

6. The Repository model is generated based on the information in the excel sheet.



TIBCO® MDM Studio Repository Designer User Guide

312 | Repository Model in Excel Format

Exporting Repository Model in Excel File Format
You can export Repository Model in Excel file format.

Procedure
1. Right click on the Repository Models, click Export and click Export.

2. The Export wizard is displayed.

Expand the RepoModel2Excel folder, select RepoModel2Excel and click Next.
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3. The Repository to Excel Export Wizard is displayed.

Select the repository model which you want to export to excel format. By default, the
project location is /Exports/MDMExportFolder, select Path, click Browse and
navigate to the new location. Click Finish.

Note: If you select multiple repository model to export, separate excel files
are created.

4. The Project Explorer displays the Excel format in MDMExportFolder.
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Deploy Repository Model
You can select the appropriate repository model, to deploy from the select module page or
you can select the enterprise to deploy. Selecting the standard enterprise option deploys
the repositories at application level.

For more information on how to deploy repository model, see Deployment
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Deployment
This chapter explains direct deployment of repository and other models created in TIBCO
MDM Studio.

Deployment Overview
This direct deployment of models created in TIBCO MDM Studio provides a quick way to
deploy the graphically defined components - rather than using the export wizard and
importing or moving the exported file to the TIBCO MDM Studio manually.

Setting Server Validation Preferences
The following steps are involved in setting server validation preferences:

Procedure
1. On the menu bar, click Windows and select Preferences. The Preferences dialog box

opens.
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2. In the left navigation pane of the Preferences dialog box, click Repository Designer >
Server Validations. The Server Validations Page opens in the right pane.

3. On the Server Validations page, select the Allow Deployment on server side
validation error check box and click Apply.
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4. To save all changes, click OK.
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Command Line Interface
This chapter introduces the Command Line Interface (CLI) added to TIBCO MDM Studio for
automated use of the application.

Overview
With TIBCO MDM Studio evolving, all the design time activities are done using TIBCO MDM
Studio. It is necessary to expose these design time activities and similar interface scripts
which support in automatic deployment and testing.

To achieve this, the Command Line Interface (CLI) is introduced. The command line
interface services are used for external actions such as export and deployment. In this
chapter we will go through each of these external actions interfaces and the various
command line services used to execute each of the actions.

Export Interfaces
Using TIBCO MDM export wizards we can export the Repository Models, Rulebases, and
Workflows however to use this from an automated program is hard. It is easier to use this
from the command line.

Using the command line the design artifacts (.rep, .rul, .xpdl) are transformed from the
eclipse based format into the format executable by the TIBCO MDM Server. The
transformed artifacts are imported into the TIBCO MDM server.

Note: On Linux, manually create an export folder in your workspace. Specify the
path of the export folder while defining the output file.

Note: While running the sample from the documentation, if you encounter error,
copy the syntax to a text editor and retype the hyphen.
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Data Source Export Transformation
To transform a data source file to into a specific TIBCO MDM server format, use the
following syntax in the command line. The file name and the workspace information is
mandatory in the syntax.

For Windows

<install dir>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.mdm.datasourcemodel.export.TransformDataSource -i <input file> -o <output
file>

-i : <full path to the input data source file>

-o : <full path to the output metadata file containing the data source information>

For example,

<install dir>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -
application com.tibco.mdm.datasourcemodel.export.TransformDataSource -i
c:\Users\myname\workspace\MyProject\Datasources\Names.ds -o
c:\Users\myname\workspace\MyProject\Datasources\export\Names.xml

For Linux

./TIBCOBusinessStudio -application
com.tibco.mdm.datasourcemodel.export.TransformDataSource -i <input file> -o <output
file>

-i : <full path to the input data source file>

-o : <full path to the output metadata file containing the data source information>

For example,

./TIBCOBusinessStudio -application
com.tibco.mdm.datasourcemodel.export.TransformDataSource -i
/home/apps/workspace/MyProject/Datasources/Names.ds -o
/home/apps/workspace/MyProject/Datasources/export/Names.xml
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Synchronization Format Export Transformation
To transform a synchronization file to into a specific TIBCO MDM server format, use the
following syntax in the command line. The file name and the workspace information is
mandatory in the syntax.

For Windows

<Install Dir>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.mdm.syncformat.editor.TransformSyncFormat -data <full path to the Workspace
Directory> -i <input file> -o <output file>

-i : <full path to the input data source file>

-o : <full path to the output metadata file containing the data source information>

For example,

<Install Dir>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.mdm.syncformat.editor.TransformSyncFormat -data
"c:\Users\myname\workspace" -i "c:\Users\myname\workspace\MyProject\Sync
Formats\SyncFormat.sf" -o "c:\Users\myname\workspace\MyProject\Sync
Formats\Export\SyncFormat.xml"

For Linux

./TIBCOBusinessStudio -application
com.tibco.mdm.syncformat.editor.TransformSyncFormat -data <full path to the Workspace
Directory> -i <input file> -o <output file>

-i : <full path to the input data source file>

-o : <full path to the output metadata file containing the data source information>

For example,

./TIBCOBusinessStudio -application
com.tibco.mdm.syncformat.editor.TransformSyncFormat -data "/home/apps/workspace" -i
"/home/apps/workspace/MyProject/Sync Formats/SyncFormat.sf" -o
"/home/apps/workspace/MyProject/Sync Formats/Export/SyncFormat.xml"
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Repository Model Export Transformation
To transform a repository file to into a specific TIBCO MDM server format, use the following
syntax in the command line. The file name and the workspace information is mandatory in
the syntax.

For Windows

<Install Dir>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.mdm.repositorymodel.export.TransformRepository -data <full path to the
Workspace Directory> -i <input file> -o <output file>

-i: <full path to the input repository file>

-o: <full path to the output metadata file containing the repository information>

For example,

<Install Dir>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.mdm.repositorymodel.export.TransformRepository -data
"c:\Users\myname\workspace" -i "c:\Users\myname\workspace\MyProject\Repository
Models\Person.rep" -o "c:\Users\myname\workspace\MyProject\Repository
Models\Export\Person.xml"

For Linux

./TIBCOBusinessStudio -application
com.tibco.mdm.repositorymodel.export.TransformRepository -data <full path to the
Workspace Directory> -i <input file> -o <output file>

-i: <full path to the input repository file>

-o: <full path to the output metadata file containing the repository information>

For example,

./TIBCOBusinessStudio -application
com.tibco.mdm.repositorymodel.export.TransformRepository -data
"/home/apps/workspace" -i "/home/apps/workspace/MyProject/Repository
Models/Person.rep" -o "/home/apps/workspace/MyProject/Repository
Models/Export/Person.xml"
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Rulebase Export Transformation
To transform a single rulebase design file into a specific TIBCO MDM server format, use the
following syntax in the command line. The file name and the workspace information is
mandatory in the syntax.

For Windows

<Install Dir>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.mdm.rulebasemodel.transformation.TransformRulebase -data <Workspace Dir> -i
<input file> -o <output file>

-i: <full path to the input rulebase file>

-o: <full path to the output metadata file containing the rulebase information>

For example,

<Install Dir>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.mdm.rulebasemodel.transformation.TransformRulebase -data
"c:\Users\myname\workspace" -i "c:\Users\myname\workspace\MyProject\Rulebase
Models\Basic.rul" -o "c:\Users\myname\workspace\MyProject\Rulebase
Models\Export\Basic.xml"

For Linux

./TIBCOBusinessStudio -application
com.tibco.mdm.rulebasemodel.transformation.TransformRulebase -data <Workspace Dir> -i
<input file> -o <output file>

-i: <full path to the input rulebase file>

-o: <full path to the output metadata file containing the rulebase information>

For example,

./TIBCOBusinessStudio -application
com.tibco.mdm.rulebasemodel.transformation.TransformRulebase -data
"/home/apps/workspace" -i "/home/apps/workspace/MyProject/Rulebase Models/Basic.rul"
-o "/home/apps/workspace/MyProject/Rulebase Models/Export/Basic.xml"
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Workflow Export Transformation

Note: For Linux, copy the latest CIMServices.wsdl from <Workspace Dir>/<project
name>/Service Descriptors to <Install Dir>/studio-mdm/<version>/eclipse for
process transformation.

To transform a single workflow design file (XPDL) into a specific TIBCO MDM server format,
use the following syntax in the command line. The file name and the workspace
information is mandatory in the syntax.

For Windows

<Install Dir>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.cim.export.TransformProcessFlow -data <Workspace Dir> -i <input file> -o
<output file>

-i: <full path to the input process package file>

-o: <full path to the output metadata file containing the process package information>

For example,

<Install Dir>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.cim.export.TransformProcessFlow -data "c:\Users\myname\workspace" -i
"c:\Users\myname\workspace\MyProject\Process Packages\ProcessPackage.xpdl" -o
"c:\Users\myname\workspace\MyProject\Process Packages\Export\ProcessPackage.xml"

For Linux

./TIBCOBusinessStudio -application com.tibco.xpd.cim.export.TransformProcessFlow -data
<Workspace Dir> -i <input file> -o <output file>

-i: <full path to the input process package file>

-o: <full path to the output metadata file containing the process package information>

For example,

./TIBCOBusinessStudio -application com.tibco.xpd.cim.export.TransformProcessFlow -data
"/home/apps/workspace" -i "/home/apps/workspace/MyProject/Process
Packages/ProcessPackage.xpdl" -o "/home/apps/workspace/MyProject/Process
Packages/Export/ProcessPackage.xml"
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Deploy Interfaces
The following section depicts how to deploy the Data Sources, Synchronization Formats,
Repository Models, Rulebase Models and Workflow Models.

The parameters passed in the deployment syntax are as follows:

-data : fully qualified path to the workspace

-u : username of the login user. The user must have administrator privileges.

-pwd : password of the administrator login user.

-mode: Mode of deployment. It must be 'project' for project deployment. The flag also
supports the values of 'rep','rul,'xpdl','project','ds','sf'.

-baseURL : The BaseURL to deploy the TIBCO MDM Project.

-project_name : TIBCO MDM Studio project name. It is also the name of the folder which
contains the project file.

-e : User enterprise name.

-d : Enterprise where the project is deployed.

-nodatafile : this switch is optional. If actual data file is associated with datasource it is
deployed by default. However, if -nodatafile switch is set then it is not deployed.

-datafilepath : this switch is optional. If actual data file is associated with datasource it is
deployed by default. However, if -nodatafile switch is set then it is not deployed. If file is
placed at relative path then mention -datafilepath <path of file>, only one flag is supported
at a time in command -datafilepath or -nodatafile.

-datafilepath : this switch is optional. If actual data file is associated with datasource it is
deployed by default. However, if -nodatafile switch is set then it is not deployed. If file is
placed at relative path then mention -datafilepath <path of file>, only one flag is supported
at a time in command -datafilepath or -nodatafile.

Note: While running the sample from the documentation, if you encounter error,
copy the syntax to a text editor and retype the hyphen.
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Data Source Deployment
To deploy data source, file uploaded to the data source is automatically deployed if -
nodatafile parameter is not provided. To deploy a data source from eclipse format to a
specific TIBCO MDM server, use the following syntax in the command line.

For Windows

<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.deploy.server.cim.DeployModel -data <Workspace Directory> -u <username>
-pwd <password> -mode ds -baseURL <BaseURL> -i <input file> -e <User Enterprise> -d
<Deployment Enterprise> -datafilepath <location of datafile>

For example,

<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.deploy.server.cim.DeployModel -data "c:\Users\mdm\workspace" -u jsmith -
pwd jsmith -mode ds -baseURL http://localhost:8080 -i
"c:\Users\myname\workspace\MyProject\Datasources\Contact.ds" -e techpubs -d techpubs
-datafilepath "C:\Users\DataFile.txt"

For Linux

./TIBCOBusinessStudio -application com.tibco.xpd.deploy.server.cim.DeployModel -data
<Workspace Directory> -u <username> -pwd <password> -mode ds -baseURL <BaseURL> -i
<input file> -e <User Enterprise> -d <Deployment Enterprise> -datafilepath <location of
datafile>

For example,

TIBCOBusinessStudio.exe -application com.tibco.xpd.deploy.server.cim.DeployModel -data
"c:\Users\mdm\workspace" -u jsmith -pwd jsmith -mode ds -baseURL http://localhost:8080
-i "c:\Users\myname\workspace\MyProject\Datasources\Contact.ds" -e techpubs -d
techpubs -datafilepath "C:\Users\DataFile.txt"

Synchronization Format Deployment
To deploy a synchronization format from eclipse format to a specific TIBCO MDM server,
use the following syntax in the command line.
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For Windows

<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.deploy.server.cim.DeployModel -data <Workspace Directory> -u <username>
-pwd <password> -mode sf -baseURL <BaseURL> -i <input file> -e <User Enterprise> -d
<Deployment Enterprise>

For example,

<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.deploy.server.cim.DeployModel -data "c:\Users\mdm\workspace" -u jsmith -
pwd jsmith -mode sf -baseURL http://localhost:8080 -i
"c:\Users\myname\workspace\MyProject\Sync Formats\SalesForce.sf" -e techpubs -d
techpubs

For Linux

./TIBCOBusinessStudio -application com.tibco.xpd.deploy.server.cim.DeployModel -data
<Workspace Directory> -u <username> -pwd <password> -mode sf -baseURL <BaseURL> -i
<input file> -e <User Enterprise> -d <Deployment Enterprise>

For example,

./TIBCOBusinessStudio -application com.tibco.xpd.deploy.server.cim.DeployModel -data
"/home/apps/workspace" -u jsmith -pwd jsmith -mode sf -baseURL http://localhost:8080 -i
"/home/apps/workspace/MyProject/Sync Formats/SalesForce.sf" -e techpubs -d techpubs

Repository Model Deployment
To deploy a single repository model file from eclipse format to a specific TIBCO MDM
server, use the following syntax in the command line. The repository file translation should
be performed before deployment.

For Windows

<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.deploy.server.cim.DeployModel -data <Workspace Directory> -u <username>
-pwd <password> -mode rep -baseURL <BaseURL> -i <input file> -e <User Enterprise> -d
<Deployment Enterprise>

For example,
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<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.deploy.server.cim.DeployModel -data "c:\Users\mdm\workspace" -u jsmith -
pwd jsmith -mode rep -baseURL http://localhost:8080 -i
"c:\Users\myname\workspace\MyProject\Repository Models\Person.rep" -e techpubs -d
techpubs

For Linux

./TIBCOBusinessStudio -application com.tibco.xpd.deploy.server.cim.DeployModel -data
<Workspace Directory> -u <username> -pwd <password> -mode rep -baseURL <BaseURL> -i
<input file> -e <User Enterprise> -d <Deployment Enterprise>

For example,

./TIBCOBusinessStudio -application com.tibco.xpd.deploy.server.cim.DeployModel -data
"/home/apps/workspace" -u jsmith -pwd jsmith -mode rep -baseURL http://localhost:8080 -
i "/home/apps/workspace/MyProject/Repository Models/Person.rep" -e techpubs -d
techpubs

Rulebase Model Deployment
To deploy a single rulebase model file from eclipse format to a specific TIBCO MDM server,
use the following syntax in the command line. As a result of the deployment the master
catalog folder is added or overwritten in the deployment folder in the TIBCO MDM server.

For Windows

<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.deploy.server.cim.DeployModel -data <Workspace Dir> -u <username> -pwd
<password> -mode rul -baseURL <BaseURL> -i <input file> -e <User Enterprise> -d
<Deployment Enterprise>

For example,

<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.deploy.server.cim.DeployModel -data "c:\Users\myname\workspace" -u
jsmith -pwd jsmith -mode rul -baseURL http://localhost:8080 -i
"c:\Users\myname\workspace\MyProject\Rulebase Models\Basic.rul" -e techpubs -d
techpubs

For Linux
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./TIBCOBusinessStudio -application com.tibco.xpd.deploy.server.cim.DeployModel -data
<Workspace Dir> -u <username> -pwd <password> -mode rul -baseURL <BaseURL> -i <input
file> -e <User Enterprise> -d <Deployment Enterprise>

For example,

./TIBCOBusinessStudio -application com.tibco.xpd.deploy.server.cim.DeployModel -data
"/home/apps/workspace" -u jsmith -pwd jsmith -mode rul -baseURL http://localhost:8080 -i
"/home/apps/workspace/MyProject/Rulebase Models/Basic.rul" -e techpubs -d techpubs

Workflow Model Deployment
To deploy a single workflow model file from eclipse format to a specific TIBCO MDM server.
This will result in one file added/overwritten in the workflow deployment folder in the
TIBCO MDM server (common workflow folder in most cases).

For Windows

<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.deploy.server.cim.DeployModel -data <"full path of the Workspace"> -u
<username having admin login credentials> -pwd <password having admin login
credentials> -mode xpdl -baseURL <the BaseURL to deploy the MDM Design service> -i
<"full path to the .xpdl file"> -e <User Enterprise> -d <Deployment Enterprise>

For example,

<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.deploy.server.cim.DeployModel –data "c:\Users\myname\workspace" -u
jsmith -pwd jsmith -mode xpdl -baseURL http://localhost:8080 -i
"c:\Users\myname\workspace\MyProject\Process Packages\ProcessPackage.xpdl" -e
techpubs -d techpubs

For Linux

./TIBCOBusinessStudio -application com.tibco.xpd.deploy.server.cim.DeployModel -data
<"full path of the Workspace"> -u <username having admin login credentials> -pwd
<password having admin login credentials> -mode xpdl -baseURL <the BaseURL to deploy
the MDM Design service> -i <"full path to the .xpdl file"> -e <User Enterprise> -d
<Deployment Enterprise>

For example,
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./TIBCOBusinessStudio -application com.tibco.xpd.deploy.server.cim.DeployModel –data
"/home/apps/workspace" -u jsmith -pwd jsmith -mode xpdl -baseURL http://localhost:8080
-i "/home/apps/workspace/MyProject/Process Packages/ProcessPackage.xpdl" -e techpubs
-d techpubs

Deploy Projects
The deployment of an entire TIBCO MDM Studio project is also supported, including all
.rep, .rul and .xpdl model files, from their eclipse format to a specific TIBCO MDM server.
Since the deployment includes lot of artifacts a check is done. The deployment process is
terminated as soon as an error occurs. The error details are captured in error log.

The interface takes the workspace location and the project name (same as folder) and then
iterates through all the folders and adds all Data Source, Rulebase, Repository Model and
Process Designer files definition of a project. In addition, you can also deploy limited set of
artifacts by adding a file list as an argument to the project deployment.

To deploy the entire TIBCO MDM Studio project, use the following syntax in the command
line.

<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.deploy.server.cim.DeployModel -data <Workspace Dir> -u <username> -pwd
<password> -mode project -baseURL <BaseURL> -project_name <Project Name> -e <User
Enterprise> -d <Deployment Enterprise> (-abort_on_error) -fileFilter <deployment
file1>,<deployment file2>,

-data : fully qualified path to the workspace

-u : username of the login user. The user must have administrator privileges.

-pwd : password of the administrator login user.

-mode: Mode of deployment. It must be 'project' for project deployment. The flag also
supports the values of 'rep','rul,'xpdl','project',’ds’,’sf’.

-baseURL : The Base URL to deploy the TIBCO MDM Project.

-project_name : TIBCO MDM Studio project name. It is also the name of the folder which
contains the project file.

-e : User enterprise name.

-d : Enterprise where the project is deployed.
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-abort_on_error : aborts on encountering an error.

-fileFilter : this switch is optional. If specified, only files from the list are deployed. If not
specified, all the files from the project are deployed.

The sample deploys the project "Demo" to a localhost server in a techpubs enterprise.

Note: While running the sample from the documentation, if you encounter error,
copy the syntax to a text editor and retype the hyphen.

For Windows

<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -application
com.tibco.xpd.deploy.server.cim.DeployModel -data "c:\Users\myname\workspace" -
project_name Demo -u jsmith -pwd jsmith -mode project -baseURL http://localhost:8080 -e
techpubs -d techpubs -abort_on_error -fileFilter "Repository
Models\RepoAllTypeAttributes.rep,Rulebase Models\RepoWithAllTypes.rul,Sync
Formats\SyncFormat.sf,Process
Packages\wfin26productaddinternaleditv1.xpdl,Datasources\LanguageCodes.ds"

For Linux

./TIBCOBusinessStudio -application com.tibco.xpd.deploy.server.cim.DeployModel -data
"/home/apps/workspace" -project_name Demo -u jsmith -pwd jsmith -mode project -
baseURL http://localhost:8080 -e techpubs -d techpubs -fileFilter "Repository
Models/RepoAllTypeAttributes.rep,Rulebase Models/RepoWithAllTypes.rul,Sync
Formats/SyncFormat.sf,Process
Packages/wfin26productaddinternaleditv1.xpdl,Datasources/Country.ds"

Incremental Deployment of Repositories
The incremental deployment is currently supported only for .rep.

To incremental deploy a single project, use the following syntax in the command line.

./TIBCOBusinessStudio -application
com.tibco.xpd.deploy.server.cim.DeployModel -data <Workspace Directory>
-u <username> -pwd <password> -mode rep -baseURL <BaseURL> -i
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<repository model input file> -e <User Enterprise> -d <Deployment
Enterprise> -repositoryFilter "PERSON,ADDRESS,LOCATION" -
relationshipFilter "PERSON\PersonToAddress,ADDRESS\AddressOfPerson" -
inputmapFilter "PERSON\InputMap1,ADDRESS\InputMap2" -outputmapFilter
"PERSON\OutputMap1" -classificationFilter "PERSON\Classification1"

-data : fully qualified path to the workspace

-u : username of the login user. The user must have administrator privileges.

-pwd : password of the administrator login user.

-mode: Mode of deployment. It must be 'project' for project deployment. The flag supports
the values only of 'rep'.

-baseURL : The Base URL to deploy the TIBCO MDM Project.

-i : full path to the repository model.

-e : User enterprise name.

-d : Enterprise where the project is deployed.

-repositoryFilter : repository names which you want to filter.

-relationshipFilter : relationship names which you want to filter.

-inputmapFilter : inputmap names which you want to filter.

-outputmapFilter : output names which you want to filter.

-classificationFilter : classification names which you want to filter.

The sample deploys the project "Demo" to a localhost server in a techpubs enterprise.

For Windows

<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe
-application com.tibco.xpd.deploy.server.cim.DeployModel -data
"c:\Users\myname\workspace" -u jsmith -pwd jsmith -mode rep -baseURL
http://localhost:8080 -i
"c:\Users\myname\workspace\Demo\RepositoryModels\Demo.rep" -e techpubs -
d techpubs -repositoryFilter "PERSON,ADDRESS,LOCATION" -
relationshipFilter "PERSON\PersonToAddress,ADDRESS\AddressOfPerson" -
inputmapFilter "PERSON\InputMap1,ADDRESS\InputMap2" -outputmapFilter
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"PERSON\OutputMap1" -classificationFilter "PERSON\Classification1"

For Linux

/TIBCOBusinessStudio -application
com.tibco.xpd.deploy.server.cim.DeployModel -data "/home/apps/workspace"
-u jsmith -pwd jsmith -mode rep -baseURL http://localhost:8080 -i
"/home/apps/workspace/Demo/RespositoryModels/Demo.rep" -e techpubs -d
techpubs -repositoryFilter "PERSON,ADDRESS,LOCATION" -relationshipFilter
"PERSON\PersonToAddress,ADDRESS\AddressOfPerson" -inputmapFilter
"PERSON\InputMap1,ADDRESS\InputMap2" -outputmapFilter
"PERSON\OutputMap1" -classificationFilter "PERSON\Classification1"

Custom Form Deployment
Custom forms can be deployed in both Windows and Linux environments. From the CLI,
you can deploy a single custom form or multiple custom forms to the TIBCO MDM server.
To deploy the custom forms use the following properties and syntax in the Command Line
Interface:

Deploying a Single Custom Form

You can deploy a single custom form to the TIBCO MDM server in a Windows or a Linux
environment.
For Windows

To deploy a single custom form, enter the following command at the command prompt:

<Install Dir>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe -
application com.tibco.xpd.deploy.server.cim.DeployModel -data "D:/cim_
Studio/Studio_Projects_Ws_1" -i "D:\cim_Studio\Studio_Projects_Ws_
1\UiPageDeploy\UI Builder\UiCustomPage5.mub" -u cim90 -pwd cim90 -mode
mub -baseURL http://localhost:8080/ -e cimdev90 -d cimdev90 -
uiPageConfiguration ["menuAction":"Add to Menu","rootItem":"Custom
Pages","menuItem":"UiCustomPage5","metadataOperation":"[Add Record, View
Record, Modify
Record]","directoryStructure":"Default","componentName":"UiCustomPage5"]

For Linux
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To deploy a single custom form, enter the following command at the command prompt:

./ TIBCOBusinessStudio.exe -application
com.tibco.xpd.deploy.server.cim.DeployModel -data
“/home/apps/workspace/UiPageDeploy/UI Builder/UiCustomPage5.mub” -i
“/home/apps/workspace” u cim90 -pwdcim90 -mode mub -baseURL
http://localhost:8080/ -e cimdev90 -d cimdev90 -uiPageConfiguration
["menuAction":"Add to
Menu","rootItem":"CustomPages","menuItem":"UiCustomPage5","metadataOpera
tion":"[Add Record, View Record, Modify
Record]","directoryStructure":"Default","componentName":"UiCustomPage5"]

To deploy a single custom form, use the following properties:

Properties Description

–mode The mode in which you want to deploy the custom form. For example,

–mode mub

-i A full path of the input UI builder file

–
uiPageConfigurat
ion

Page configuration in square brackets followed by the –
uiPageConfiguration flag.

For example,

-uiPageConfiguration ["menuAction":"Add to
Menu","rootItem":"Custom
Pages","menuItem":"UiCustomPage5","metadataOperation":"
[Add Record, View Record, Modify
Record]","directoryStructure":"Default","componentName":
"UiCustomPage5"]

-menuAction Add to Menu or Link to Metadata Operation

l If you add the value of -menuAction as Add to Menu, then -
metadataOperation is optional .

l If you add the value of -menuAction as Link to Metadata
Operation, then -rootItem and –menuItem are optional.
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-
directoryStructu
re

The directory structure such as Default or Standalone

-
metadataOperatio
n

The operations such as Add Record, View Record, and Modify Record

-rootItem Provide any of the following root items:

l Custom Pages

l Inbox

l Administration

l System Operations

l Master Data

l Browse and Search

l Business Process

l Event Log

l Tools

Deploying Multiple Custom Forms at a Time
For Windows

To deploy multiple custom forms at a time, enter the following command on the command
line:

<Install Directory>\studio-mdm\<version>\eclipse>TIBCOBusinessStudio.exe
-application com.tibco.xpd.deploy.server.cim.DeployModel -data " D:\cim_
Studio\Studio_Projects_Ws_1" -project_name UiPageDeploy -u cim90 -pwd
cim90 -mode project -baseURL http://localhost:8080 -e cimdev90 -d
cimdev90 -abort_on_error -fileFilter "UI Builder\UiCustomPage1.mub,UI
Builder\UiCustomPage2.mub,UI Builder\UiCustomPage3.mub" -
uiPageConfiguration "C:\Users\amshinde\Desktop\uiconfig.json"

For Linux

To deploy multiple custom forms at a time, enter the following command on the command
line:
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./TIBCOBusinessStudio -application
com.tibco.xpd.deploy.server.cim.DeployModel -data "/home/apps/workspace"
-project_name UiPageDeploy -u cim90 -pwd cim90 –mode project -baseURL
http://localhost:8080 –e cimdev90 -d cimdev90 -fileFilter
"UIBuilder\UiCustomPage1.mub,UI Builder\UiCustomPage2.mub,UI
Builder\UiCustomPage3.mub” –uiPageConfiguration
"/home/apps/workspace/uiconfig.json"

To deploy multiple custom forms at a time use the following properties:

Propertie
s

Description

–mode A mode in which you want to deploy the custom form. For example,

–mode project

-
fileFilte
r

A filter to specify files that you want to deploy. This is optional, all the files in a
project are deployed by default. Use this filter only to deploy specific files. For
example, "UI Builder\UiCustomPage1.mub,UI Builder\UiCustomPage2.mub"

–
uiPageCon
figuratio
n

(file path)

UI Page configuration –uiPageConfiguration file path. For example,

-uiPageConfiguration "C:\Users\amshinde\Desktop\uiconfig.json"

–
uiPageCon
figuratio
n

(file)

The format of –uiPageConfiguration written in the .json file:

{"UiCustomPage1":{"menuAction":"Add to Menu","rootItem":"Custom
Pages","menuItem":"UiCustomPage1","metadataOperation":"","direc
toryStructure":"Default","componentName":"UiCustomPage1"},"UiCu
stomPage2":{"menuAction":"Add to Menu","rootItem":"Custom
Pages","menuItem":"UiCustomPage2","metadataOperation":"","direc
toryStructure":"Default","componentName":"UiCustomPage2"}}
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Custom Import

Custom Import Sample Project
A sample plug-in has been provided for reference on how to import repository metadata
from custom XML format.

This sample provides an example that facilitates user to import metadata from TIBCO MDM
version 9.1.1 format.

Download the Sample
To download the custom import sample, refer Accessing Samples

View the Sample Project
A project named Repository Model - Custom Import Plug-ins will be available in the
workspace and can be modified. The perspective automatically changes to Java.

Edit the Sample Project
The different import formats can be implemented by changing the xsl file
(XSLT/CimToRep.xsl).
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Note: The name of the xsl file is fixed (CimToRep.xsl) but can be changed in the
RepoImportWizard.java file.

The xslt file can be modified through the Eclipse editor:

The supplied xslt transforms the TIBCO MDM Server 7.2 export meta format into the
Repository Designer format.

Note: The <DataDomain> part of the structure has to be generated by the xslt
transformation and contains the structural model. The <Diagram> section is
automatically generated after xslt transformation.

Running and Debugging the Project
The project can be run (and debugged) using the Run (or Debug) dialog.

Procedure
1. Goto Run > Run Configurations

2. Right click Eclipse and select New to create a new Eclipse Application (for example,
Test).
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3. Adjust the memory parameter by going to the Arguments tab and adding the
following into the VM arguments section: (-XX:MaxPermSize=256m -Xmx384m)

4. Click Apply and then click Run. A new application will come up and the new wizard
can be tested and debugged. The File > Import menu will show the new wizard.
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Exporting and Deploying
The plugin can be exported as a deployable plugin and added to the distribution plugin
folder for deployment.

Procedure
1. Right click the Project and select Export.

2. Select Plug-in Development > Deployable plug-ins and fragments.

3. Select the plug-in to export and destination directory. Click Next.

4. Click Finish.
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5. Copy the exported plug-in jar into <BS_INSTALL_HOME>\studio\<version>\studio-
addins\eclipse\plugins.

6. Restart TIBCO MDM Studio and verify that the custom import plug-in works properly.
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Data Source Explorer
This chapter describes the process for creating a new database connection profile.

Data Source Explorer
The Data Source Explorer contains connection profile instances. The Data Source Explorer
provides a list of configured connection profiles. If categories are enabled, you can see the
list grouped into categories, for example, Databases and ODA Data Sources. Use the Data
Source Explorer to connect to, navigate, and interact with resources associated with the
selected connection profile.

Creating a New Database Connection profile
A connection profile contains the connection property information needed to connect to a
database runtime instance.

Warning: Ensure that the database server is running before attempting to test
the connection or to connect to the database server.

Procedure
1. In Data Source Explorer, Right-click on Database Connections and select New.

2. The new connection profile dialog box is displayed.
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3. Select the database from the filter type list for which you want to create a
connection profile. For example, to list all databases that begin with the letter D,
enter a d in the text box. You can also enter a text string such as JDBC or embedded
to filter the list

4. Change the Name from the system-provided default, and enter a Description. You
must change the name if a connection profile already exists with the same name.

5. Click Next.

6. The driver details dialog box for the selected database if displayed.
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7. Select the appropriate driver from the drop-down list. If a driver definition does not
exist for the database type selected, you can create one. Click to create a new
driver definition. Select to edit an existing driver definition. .

8. The Properties tab displays the default template information for the selected driver.
Add or modify the Properties information in the General or Optional Properties tabs.

l Select the Save Password checkbox to save the password for the database
server login.

l Select Connect When the Wizard Completes checkbox to connect to the
database server once you finish defining this connection profile.

l Select Connect Every Time the Workbench Is Started checkbox to
automatically connect to the database server using this connection profile when
you launch Eclipse.

l Click Test Connection to ping the server and to verify that the connection
profile is working.

9. If you want to create database select the Create database checkbox and if you want
to upgrade your database then select the Upgrade database to current version
checkbox.



TIBCO® MDM Studio Repository Designer User Guide

344 | Data Source Explorer

10. Click Next to view Summary information.

11. Click Finish to create the connection profile.
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Troubleshooting

This appendix lists some of the common errors and ways to troubleshooting them.

General Troubleshooting

Failing Deployment
Issue: Repository Model deployment on WebSphere Application Server failed with error
"java.sql.SQLException: ORA-01430: column being added already exists in table " on TIBCO
MDM server.

Solution: On Websphere Application Server, the datasource property "Statement cache
size" property value is 10. Set the "Statement cache size" property value to 0. An incorrect
setting may result in a TransactionRolledback exception. This setting is Windows-specific.

To change statement cache size:

Login to the Administrative console to configure the properties.

In the left panel, expand Resources > JDBC Providers. The Data Sources panel is displayed
on the right.

Under Preferences, click data source name. For example, eCMDataSource. The
Configuration tab is displayed.

Under Additional Properties, click the WebSphere Application Server data source
properties link.

In the Statement cache size field, enter 0.

Click the OK button. A message is displayed with the Save and Review options.

Click the Save link to save changes to the master configuration.
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TIBCO Documentation and Support Services
For information about this product, you can read the documentation, contact Support, and
join Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the Product Documentation website,
mainly in HTML and PDF formats.

The Product Documentation website is updated frequently and is more current than any
other documentation included with the product.

Product-Specific Documentation

The documentation for this product is available on the TIBCO® MDM Studio Documentation
page.

How to Contact Support for TIBCO Products

You can contact the Support team in the following ways:

l To access the Support Knowledge Base and getting personalized content about
products you are interested in, visit our product Support website.

l To create a Support case, you must have a valid maintenance or support contract
with a Cloud Software Group entity. You also need a username and password to log
in to the product Support website. If you do not have a username, you can request
one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature

https://docs.tibco.com/
https://docs.tibco.com/
http://docs.tibco.com/products/tibco-mdm-studio-latest
https://support.tibco.com/
https://support.tibco.com/
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requests from within the TIBCO Ideas Portal. For a free registration, go to
TIBCO Community.

https://ideas.tibco.com/
https://community.tibco.com/
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Legal and Third-Party Notices
SOME CLOUD SOFTWARE GROUP, INC. (“CLOUD SG”) SOFTWARE AND CLOUD SERVICES EMBED,
BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER CLOUD SG SOFTWARE
(COLLECTIVELY, “INCLUDED SOFTWARE”). USE OF INCLUDED SOFTWARE IS SOLELY TO ENABLE THE
FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED CLOUD SG
SOFTWARE AND/OR CLOUD SERVICES. THE INCLUDED SOFTWARE IS NOT LICENSED TO BE USED OR
ACCESSED BY ANY OTHER CLOUD SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER
PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS AND CONDITIONS
OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED AGREEMENT, OR, IF THERE IS NO
SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER AGREEMENT WHICH IS DISPLAYED WHEN
ACCESSING, DOWNLOADING, OR INSTALLING THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP
END USER AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE
OF THIS DOCUMENT IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF
SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of Cloud Software
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, BusinessConnect, ActiveMatrix BusinessWorks, and
Enterprise Message Service are either registered trademarks or trademarks of Cloud Software Group,
Inc. in the United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only. You acknowledge that all
rights to these third party marks are the exclusive property of their respective owners. Please refer to
Cloud SG’s Third Party Trademark Notices (https://www.cloud.com/legal) for more information.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

Cloud SG software may be available on multiple operating systems. However, not all operating
system platforms for a specific software version are released at the same time. See the “readme” file
for the availability of a specific version of Cloud SG software on a specific operating system platform.

https://www.cloud.com/legal
https://scripts.sil.org/OFL
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SG MAY MAKE IMPROVEMENTS AND/OR CHANGES IN
THE PRODUCT(S), THE PROGRAM(S), AND/OR THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY
TIME WITHOUT NOTICE.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "README" FILES.

This and other products of Cloud SG may be covered by registered patents. For details, please refer
to the Virtual Patent Marking document located at https://www.cloud.com/legal.

Copyright © 2007-2024. Cloud Software Group, Inc. All Rights Reserved.

https://www.cloud.com/legal

	Contents
	Getting Started
	Repository Designer Overview
	What you can do with the Repository Designer

	Starting the Repository Designer
	Welcome Screen
	Accessing Samples

	Creating a new Repository Model
	Creating a new Project to hold your Repository Model (Step 1)
	Creating a Repository Model (Step 2)

	Project Explorer
	MDM Project

	Property tabs
	Repository Property section
	Relationship Property section
	Relationship Attribute Group section

	Quick Search
	Attribute and Attribute Group Repositioning
	Attribute Group Reposition
	Attribute Reposition within same Attribute Group
	Attribute Reposition from one Attribute Group to another Attribute Group

	Palette
	Association Mapping

	Repository Attributes and Relationships
	Repository Definition
	Adding a Repository (Step 1)
	From the Palette
	From the Callout Handler
	Defining Custom Properties for Repositories

	Defining Attribute Groups (Step 2)
	Defining Custom Properties for Attribute Groups

	Adding Predefined Attribute Groups
	Sample predefinedAttributeGroups.xml

	Exporting Attribute Groups
	Defining Attributes (Step 3)
	Defining Relationships (Step 4)
	A - Creating Relationship(s)
	B- Creating Relationship Attribute Group(s)
	C - Defining Relationship Attributes
	D - Connecting the Relationship Attribute Group to the Relationship

	Importing your TIBCO MDM Repository
	Exporting a Repository Model
	Importing a Repository Model

	Appearance Tab
	Appearance Tab For Repository
	Appearance Tab For Attribute Group
	Appearance Tab For Relationship Attribute Groups
	Appearance Tab For Relationship

	Data Source Editor
	Data Sources Overview
	Data Source Properties
	What you can do with the Data Source Designer

	Creating a New Data Source Model
	Modifying an Existing Data Source
	Importing an Existing Data Source Model
	Exporting a Data Source
	Deploying a Data Source

	Synchronization Format Editor
	Synchronization Formats Overview
	Creating the Synchronization Format Special Folder
	Creating a Synchronization Format
	Modify Existing Synchronization Format
	Manage Attribute Groups
	Creating a New Attribute Group
	Renaming the Attribute Group

	Importing a Synchronization Format
	Exporting a Synchronization Format
	Deploying a Synchronization Format

	Classification Scheme Editor
	Overview
	Editing Category Tree
	Browsing Category Tree

	Create Classification Schemes
	Using Classification Scheme Wizard
	Using Classification Scheme Property Section
	Deleting Classification Scheme

	Classification Scheme Editor
	The Category Code Editor allows
	Creating Classification Code Hierarchy

	Editing Classification Code
	Dragging and Dropping of Classification Code Hierarchy

	Browsing Classification Code hierarchy
	Viewing Inherited Classification Code Attributes
	Searching Classification Code Hierarchy
	Linking Category Specific Attributes with Classification Code
	Unlinking Category Specific Attributes from Classification Code

	Importing Classification Code Hierarchy
	Deploy Classification Scheme

	Perspective Editor
	Perspective Editor Overview
	Creating a Perspective
	Deploying a Perspective

	Resource Bundle
	Resource Bundle Overview
	Resource Bundle Editor
	Customize
	Search
	Filter

	Creating a Resource Bundle
	Download Custom Resource

	Resource Model Bundle Editor
	Repository Model File for Generating Resource Keys
	Customizing an Existing Properties from Model file
	Adding a New Resource Property to the Model file

	Exporting a Resource Bundle
	Deploying the Custom Resource Bundle

	Repository Model Report
	Creating a Repository Model Report
	Viewing Repository Model Report
	Index Page
	Repository Model Report
	Repository Model Information
	Repository Details
	Attributes Group Details
	Input Map Details with Input Mappings
	Output Map Details with Output Mappings
	Classification Schemes Details
	Relationships and Relationship Attribute Group
	Perspectives Details with selected Repositories and Relationships


	Input Map Editor
	Input Maps
	Creating Input Map
	Input Map Editor
	Input Map Property Section
	General Tab
	Advanced Tab - Basic
	Advanced Tab - Advanced
	Creating an Input Map with a Cross-repository Relationship

	Classification Code Mapping
	Adding Category Attributes
	Removing Category Attributes
	Selecting Primary Data Source

	Defining Input Map Mapping
	View Mapped Unmapped Mappings
	Deleting Mappings
	Adding Removing Data Source
	Deleting Input Maps

	Deploy Input Map

	Output Maps
	Creating Output Map
	Importing Predefined Output Map
	Associating Predefined Output Map with existing Repository


	Output Map Editor
	Creating a Related Output Map
	Defining Output Map Mapping
	For Repository Attributes
	For Predefined System Attributes
	For Relationship Attributes
	For Classification Scheme
	View Mapped Unmapped Mappings
	Deleting Mappings
	View Category Hierarchy

	Deleting Output Maps


	Working with PatternsIndexer Configuration Editor
	Overview
	PatternIndexer Configuration Interface
	Creating a PatternsIndexer Configuration
	PatternsIndexer Configuration Editor
	Creating IndexEntity
	Defining Indexing Repository Attributes
	UnIndexing Repository Attributes
	Dragging and Dropping of Repository on Index Entity
	Adding Relationship (Target Repository) to IndexEntity
	Delete IndexEntity
	Validate IndexEntity
	Modify the IndexEntity Properties
	Searching Nodes in IndexConfig Hierarchy

	Exporting IndexEntity
	Deploy PatternsIndexer Configuration

	Working with Custom Query Designer
	Overview
	Custom Query Configuration Interface
	Creating a Custom Query Model
	Adding a Query Config
	Adding a Querylet
	Adding a Match Case
	Custom Query Config Validations
	Exporting Custom Query Config
	Import Custom Query Config Model

	WSDL and Service Methods
	Overview
	Service Methods
	Repositories with FED attributes
	Generating WSDL
	WSDL and XML Schema Generation
	Service Methods
	JSON Format


	Deployment of Services

	Validation
	Repository Model Validation
	Display of validation errors
	Types of Validation
	Repository Level Validation
	Attribute Level Validation
	Relationship Validation
	Relationship Attribute and Relationship Attribute Group Validation
	Datasource Validation
	Output Map Validation
	Synchronization Format Validation
	Category Specific Attributes Validation



	Database Schema Objects Import
	Creating a New Database Connection profile
	Importing Model from Database Objects
	Importing a Schema Objects

	Repository Model in Excel Format
	Repository Excel File Format
	Designing Repository Model by Importing Excel File
	Exporting Repository Model in Excel File Format
	Deploy Repository Model

	Deployment
	Deployment Overview
	Setting Server Validation Preferences


	Command Line Interface
	Overview
	Export Interfaces
	Data Source Export Transformation
	Synchronization Format Export Transformation
	Repository Model Export Transformation
	Rulebase Export Transformation
	Workflow Export Transformation

	Deploy Interfaces
	Data Source Deployment
	Synchronization Format Deployment
	Repository Model Deployment
	Rulebase Model Deployment
	Workflow Model Deployment

	Deploy Projects
	Incremental Deployment of Repositories

	Custom Form Deployment

	Custom Import
	Custom Import Sample Project
	Download the Sample
	View the Sample Project
	Edit the Sample Project
	Running and Debugging the Project
	Exporting and Deploying


	Data Source Explorer
	Data Source Explorer
	Creating a New Database Connection profile


	Troubleshooting
	General Troubleshooting
	Failing Deployment


	TIBCO Documentation and Support Services
	Legal and Third-Party Notices

